Symantec NetBackup™ Replication Director Solutions Guide

The software described in this book is furnished under a license agreement and may be used only in accordance with the terms of the agreement.

Documentation version: 7.5
PN: 21220061

Legal Notice

Copyright © 2012 Symantec Corporation. All rights reserved.

Symantec and the Symantec Logo are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party ("Third Party Programs"). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, "Rights in Commercial Computer Software or Commercial Computer Software Documentation", as applicable, and any successor regulations. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

■ Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

### Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:


### Customer service

Customer service information is available at the following URL:


Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan                     customercare_apac@symantec.com
Europe, Middle-East, and Africa            semea@symantec.com
North America and Latin America            supportsolutions@symantec.com
Contents

Technical Support ........................................................................................................................................ 4

Chapter 1  Introducing NetBackup Replication Director ............... 11
            Replication Director checklist ...................................................... 11
            Configuration overview .................................................................. 13
            About Replication Director ................................................................ 15
            Process overview ............................................................................ 16
            About the roles of the plug-ins ...................................................... 17
            About administrative roles in the Replication Director configuration .................................................. 18

Chapter 2  OpenStorage partner configuration .................................. 21
            Partner requirements for a Replication Director environment .......... 21
            Updating an OpenStorage storage server to reflect plug-in updates ...................................................................................... 22
            NetApp storage configuration ........................................................... 24
            Importing existing NetApp relationships into the control of NetBackup ...................................................................................... 24

Chapter 3  NetBackup configuration ..................................................... 25
            NetBackup requirements for snapshots and snapshot replication .......................................................... 25
            NetBackup configuration ..................................................................... 26
            NetBackup naming conventions .......................................................... 28

Chapter 4  Configuring a NetBackup storage server ......................... 29
            Creating a NetBackup storage server for snapshot replication ............ 29
            Adding the storage server credentials to a NetBackup server .......... 44
            Deleting an OpenStorage storage server ............................................. 44
Chapter 5  Configuring disk pools for snapshot and replication ................................................................. 47

About disk pools for snapshots and snapshot replication .................. 47
About disk volumes for snapshots and snapshot replication ......... 48
Creating disk pools for snapshot replication ..................................... 50
Updating disk pools after volumes are added, are deleted, or are changed .................................................................................. 55
Updating an OpenStorage disk pool to reflect plug-in updates .......... 58
How to resolve snapshot disk volume changes ............................. 58
Using bpstinfo to view the replication topology of the device .......... 65
Sample bpstinfo output .................................................................. 66

Chapter 6  Configuring storage units and storage unit groups for snapshots and snapshot replication ........... 71

Creating storage units for snapshots and snapshot replication .......... 71
Creating a storage unit .................................................................. 73
Creating storage unit groups for snapshots ....................................... 75

Chapter 7  Configuring storage lifecycle policies for snapshots and snapshot replication ................................. 79

About configuring storage lifecycle policies for snapshots and snapshot replication ................................................................. 79
Creating a storage lifecycle policy for snapshots and snapshot replication .................................................................................. 81
Operation types in a storage lifecycle policy .................................... 85
    Snapshot operation ................................................................... 86
    Replication operation ............................................................. 91
    Index From Snapshot operation .............................................. 92
    Backup From Snapshot operation ........................................... 95
    Duplication operation ........................................................... 97
Retention types for storage lifecycle policy operations .................... 98
    Capacity managed retention type for SLP operations ............... 99
    Expire after copy retention type for SLP operations ............... 101
    Fixed retention type for SLP operations .................................. 101
    Maximum snapshot limit retention type for SLP operations ....... 102
    Mirror retention type for SLP operations ............................... 102
    Target retention type for SLP operations ............................... 102
# Chapter 8 Configuring backup policies to create snapshots and snapshot replication

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring a policy for use with Replication Director</td>
<td>105</td>
</tr>
<tr>
<td>About NDMP support for Replication Director</td>
<td>111</td>
</tr>
<tr>
<td>Limitations of NDMP support for Replication Director</td>
<td>112</td>
</tr>
<tr>
<td>Authorizing NetBackup access to the NDMP host</td>
<td>112</td>
</tr>
<tr>
<td>Configuring a policy to use NDMP with Replication Director</td>
<td>114</td>
</tr>
</tbody>
</table>

# Chapter 9 Restoring from a snapshot

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About restores from array-based snapshots</td>
<td>121</td>
</tr>
<tr>
<td>Restoring files and folders from an array-based snapshot</td>
<td>122</td>
</tr>
<tr>
<td>Using OpsCenter to restore from array-based snapshots</td>
<td>127</td>
</tr>
<tr>
<td>How NetApp performs a volume-level rollback restore</td>
<td>127</td>
</tr>
<tr>
<td>Restoring (rolling back) from an array-based snapshot</td>
<td>128</td>
</tr>
</tbody>
</table>

# Chapter 10 OpsCenter reporting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symantec OpsCenter reporting</td>
<td>135</td>
</tr>
<tr>
<td>Configuring alerts for OpenStorage events</td>
<td>135</td>
</tr>
<tr>
<td>Storage lifecycle policy reporting</td>
<td>136</td>
</tr>
<tr>
<td>Disk pool monitoring</td>
<td>137</td>
</tr>
<tr>
<td>Monitoring snapshot replication jobs</td>
<td>139</td>
</tr>
<tr>
<td>Reporting on storage units, storage unit groups, and storage lifecycle policies</td>
<td>140</td>
</tr>
</tbody>
</table>

# Chapter 11 Terminology

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication terminology</td>
<td>143</td>
</tr>
</tbody>
</table>

# Chapter 12 Troubleshooting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifying the version of the NetApp Plug-in for Symantec NetBackup</td>
<td>147</td>
</tr>
<tr>
<td>Throttling Replication Director operations with NetBackup</td>
<td>148</td>
</tr>
<tr>
<td>Disk Pool Configuration Wizard error</td>
<td>150</td>
</tr>
<tr>
<td>Standard policy restore error (2800)</td>
<td>150</td>
</tr>
<tr>
<td>Problems due to the use of an unsupported NetApp topology</td>
<td>151</td>
</tr>
<tr>
<td>Status 156 errors</td>
<td>154</td>
</tr>
<tr>
<td>Policy validation issues</td>
<td>155</td>
</tr>
<tr>
<td>Replication issues</td>
<td>156</td>
</tr>
<tr>
<td>Duplication issues</td>
<td>158</td>
</tr>
<tr>
<td>Assorted issues</td>
<td>158</td>
</tr>
</tbody>
</table>
Upgrades and policies that use Instant Recovery ....................... 161
Generating more detailed logs ..................................................... 161

Index ........................................................................................................ 163
Introducing NetBackup Replication Director

This chapter includes the following topics:

- Replication Director checklist
- Configuration overview
- About Replication Director
- Process overview
- About administrative roles in the Replication Director configuration

Replication Director checklist

Use Table 1-1 as a checklist to make sure that the backup environment contains the necessary hardware and software to configure and run Replication Director.

For the latest update of this document, see the NetBackup 7.5 documentation set.

**Table 1-1** Hardware and software version checklist for using Replication Director

<table>
<thead>
<tr>
<th>Area</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>NetApp NAS file services are supported (CIFS and NFS). Available in a future release:</td>
</tr>
<tr>
<td></td>
<td>- Block level device support (Fibre Channel, iSCSI)</td>
</tr>
<tr>
<td></td>
<td>- Application support</td>
</tr>
<tr>
<td></td>
<td>- Hypervisor support (VMware and Hyper-V)</td>
</tr>
<tr>
<td></td>
<td>Present in environment?</td>
</tr>
</tbody>
</table>


Table 1-1 Hardware and software version checklist for using Replication Director (continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Requirements</th>
<th>Present in environment?</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetApp hardware</td>
<td>NetApp FAS series filers. vFiler as source for SnapMirror and SnapVault is supported. NDMP must be enabled on both the primary and the secondary filers.</td>
<td></td>
</tr>
<tr>
<td>NetApp software</td>
<td>NetApp introduces support for Replication Director at the following software versions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Data ONTAP 7.3.6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ OnCommand Core Package 5.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The package includes DataFabric Manager server software (enabled by default) and the NetApp Management Console (install separately).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ NetApp Plug-in for Symantec NetBackup</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Download the plug-in from the <a href="https://www.netapp.com/support/">NetApp Support Site</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The <a href="https://www.netapp.com/support/">NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide</a> is available from the <a href="https://www.netapp.com/support/">NetApp Support Site</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information about the plug-in versions that NetBackup supports, see the Replication Director section of the <a href="https://www.netapp.com/support/">Symantec NetBackup Hardware Compatibility List (HCL)</a>.</td>
<td></td>
</tr>
<tr>
<td>NetBackup platforms</td>
<td>NetBackup 7.5 introduces support for Replication Director on the following master server, media server, and client platforms:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ AIX 6.1 and 7.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ HP-UX 11.31 IA64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Linux SUSE 10 and 11 x64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Red Hat Enterprise Linux 5 x64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Solaris SPARC64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Solaris x86-64*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Windows 2003 x86 and x64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Windows 2008 R2 x64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>*Master server and media server support only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>As additional platforms are tested, they are documented in the <a href="https://www.netapp.com/support/">NetBackup 7.x Operating System Compatibility List</a>.</td>
<td></td>
</tr>
</tbody>
</table>

See the following topics for more information:

See “Partner requirements for a Replication Director environment” on page 21.
See “NetBackup requirements for snapshots and snapshot replication” on page 25.
Configuration overview

The following table describes the steps that are required to configure snapshots and snapshot replication. Look at the referenced topic for details about each step.

Table 1-2 Configuration tasks overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Administrator</th>
<th>Description</th>
<th>Reference topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NetBackup</td>
<td>Install or upgrade NetBackup software on the master server and media server(s).</td>
<td>See “NetBackup requirements for snapshots and snapshot replication” on page 25.</td>
</tr>
</tbody>
</table>
| 2    | Storage       | Install and configure the disk array of the OpenStorage partner. For OpenStorage partner NetApp, this includes the following:  
- Install OnCommand Core Package 5.0  
The package includes DataFabric Manager server software (enabled by default).  
- Install the NetApp Plug-in for Symantec NetBackup  
- Add the DataFabric Manager data protection and provisioning license. (The installation includes only the core license.)  
**Note:** This is the server that is defined as the NetBackup storage server. | See “Partner requirements for a Replication Director environment” on page 21. |
<p>| 3    | Storage and NetBackup | Discuss the allocation of storage, based on backup configuration needs. | See “About administrative roles in the Replication Director configuration” on page 18. |
| 4    | Storage       | Configure the storage of the OpenStorage partner. (For example, create a DataFabric Manager server and apportion storage.) | See “NetApp storage configuration” on page 24. |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Administrator</th>
<th>Description</th>
<th>Reference topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>NetBackup</td>
<td>Run the Storage Server Configuration Wizard to configure the OpenStorage partner as a NetBackup storage server. (For example, to configure the DataFabric Manager server as a storage server.) Also configured as part of this wizard are the following: ■ Specify media servers that can access the storage server. ■ Create a disk pool that contains the primary snapshot. ■ Create a storage unit for the primary disk pool.</td>
<td>See “Creating a NetBackup storage server for snapshot replication” on page 29.</td>
</tr>
<tr>
<td>6</td>
<td>NetBackup</td>
<td>Create an additional disk pool for every group of disk volumes that will contain snapshot replications of the primary snapshot. As part of the Disk Pool Creation Wizard, also configure a storage unit for each disk pool.</td>
<td>See “Creating disk pools for snapshot replication” on page 50.</td>
</tr>
<tr>
<td>7</td>
<td>NetBackup</td>
<td>Create a storage unit for any operation that will produce duplications (non-snapshot copies).</td>
<td>See “Creating a storage unit” on page 73.</td>
</tr>
<tr>
<td>8</td>
<td>NetBackup</td>
<td>Configure a storage lifecycle policy. Create a new operation in the SLP for each task that the SLP is to perform. For example, create a Snapshot operation to perform the initial snapshot and a Replication operation to create a copy of the snapshot. Other operation types are available.</td>
<td>See “Creating a storage lifecycle policy for snapshots and snapshot replication” on page 81.</td>
</tr>
<tr>
<td>9</td>
<td>NetBackup</td>
<td>Configure a NetBackup policy to perform all of the operations indicated in the SLP. To do so, the Policy storage selection in the policy must indicate the SLP that is configured for snapshots and snapshot replication.</td>
<td>See “Configuring a policy for use with Replication Director” on page 105. See “Configuring a policy to use NDMP with Replication Director” on page 114. <strong>Note:</strong> Do not use the Policy Configuration Wizard or the Getting Started Wizard to configure policies for Replication Director.</td>
</tr>
</tbody>
</table>
About Replication Director

Replication Director is the implementation of NetBackup OpenStorage-managed snapshots and snapshot replication, where the snapshots are stored on the storage systems of partnering companies. Storage replication technology provides an efficient means to send copies of user data (files, applications, databases) to off-site storage as part of a disaster recovery plan.

Replication Director offers a single NetBackup interface for end-to-end data protection management for the following tasks:

- **Unified policy management.**
  Use the **NetBackup Administration Console** as the one, centralized backup infrastructure to manage the lifecycle of all data. Multiple data centers can replicate to one disaster recovery domain or one data center. Additional media servers are not needed in the remote data centers.

- **Snapshot copy management.**
  Use NetBackup to manage the entire lifecycle of the snapshot. For example, create a storage lifecycle policy that contains operations that act as instructions to create the initial snapshot, to create copies by duplication or replication, and to configure the retention period for each of the copies. Additional operations can be included in the SLP that create a backup from the snapshot, index the snapshot, and more.
  See the following for a description of the available storage lifecycle policy operations:
  See “Operation types in a storage lifecycle policy” on page 85.

- **Snapshot copy monitoring.**
  Use NetBackup OpsCenter to monitor the creation of each copy at each storage location. OpsCenter provides extensive reporting on the entire replication environment.

- **Global search and restore.**
  Recovery is available from any storage device in the environment that is defined to NetBackup. This includes recovery from the primary copy or any replicated copy on disk, or from any duplicated copy on disk or tape.

  **Note:** NetBackup 7.5 supports rollback restore from copy one only.

Replication Director makes use of OpenStorage, a Symantec API that lets NetBackup communicate with the storage implementations that conform to the API.

For more information, see the **NetBackup OpenStorage Solutions Guide for Disk**.
Replication Director uses NetApp functions to perform the following:

- **Share disks.**
  Multiple heterogeneous media servers can access the same disk volume concurrently.

- **Balance loads and tune performance.**
  NetBackup balances backup jobs and storage usage among the media servers and disk pools.

- **Make full use of disk array capabilities, including fast storage provisioning and almost unlimited storage.**

- **As an alternative to offsite vaulting.**

### Process overview

Replication Director uses NetBackup OpenStorage with a media server to access the volumes of a storage server. In NetBackup 7.5, the storage server is a NetApp DataFabric Manager server.

NetBackup uses volumes available to the storage server to store snapshots of client data. Snapshots represent a point-in-time of primary storage data as captured by the storage hardware. NetBackup can then instruct the storage server to replicate the snapshot from primary volumes to other volumes available to the storage server. The snapshot can be replicated to multiple volumes within the DataFabric Manager server, or duplicated to storage outside of the DataFabric Manager server, such as a tape device or other disk storage. Replication Director can accommodate an assortment of scenarios to meet the specific data protection needs of an organization.

No image can be moved, expired, or deleted from the volumes on the disk array unless NetBackup instructs the DataFabric Manager server to do so.

The instructions to perform the initial snapshot backup come from the **Snapshot** operation in a NetBackup storage lifecycle policy. Additional operations in the
SLP can provide instructions to create copies of the snapshot by duplication or replication, for example.

About the roles of the plug-ins

In other OpenStorage configurations, NetBackup media servers function as data movers. The media server backs up clients and transfers the data to a storage server, after which the storage server writes the data to storage.

However, the OpenStorage use of media servers for NetBackup Replication is different. Instead of actually moving the data, media servers are using a software plug-in to communicate with the DataFabric Manager server and making a request to move data. The Symantec plug-in is called the OSTPlugin and it uses the XML-based messaging SOAP protocol to query the DataFabric Manager server. The DataFabric Manager server hosts a software plug-in called the NetApp Plug-in for Symantec NetBackup. (See Figure 1-1.)

Note: In NetBackup 7.5, the communication between the two plug-ins cannot be encrypted. This is true even if the NetBackup policy has the Encryption policy attribute enabled.

- NetBackup media server, NetBackup client and the OSTPlugin
  The OSTPlugin is installed by default on NetBackup 7.5 media servers and clients.

- DataFabric Manager server and the NetApp Plug-in for Symantec NetBackup
  For installation instructions, see the NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide, available from the NetApp Support Site.

Note: In NetBackup 7.5, the NetApp Plug-in for Symantec NetBackup does not support IPv6. IPv4 is automatically used instead.
About administrative roles in the Replication Director configuration

The success of creating snapshots and snapshot replication relies on detailed, ongoing communication between two key roles in the backup environment: the role of the storage device administrator and the NetBackup administrator.

Both the storage device administrator and the NetBackup administrator must work together to determine the data security objectives of the company. Based on these objectives, both must communicate to make sure that the necessary storage is available.
<table>
<thead>
<tr>
<th>Administrative Role</th>
<th>Description</th>
<th>See</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage administrator</td>
<td>The storage administrator generally configures the disk array. The storage administrator configures the hardware and divides the storage systems into resource pools. The storage administrator communicates the host name that is exposed through the OpenStorage plug-in.</td>
<td>“NetApp storage configuration” on page 24.</td>
<td>“Problems due to the use of an unsupported NetApp topology” on page 151.</td>
</tr>
<tr>
<td>NetBackup administrator</td>
<td>The NetBackup administrator configures NetBackup to perform snapshots and snapshot replication, based on the storage that is configured by the storage administrator.</td>
<td>“NetBackup configuration” on page 26.</td>
<td></td>
</tr>
</tbody>
</table>
About administrative roles in the Replication Director configuration
This chapter includes the following topics:

- Partner requirements for a Replication Director environment
- Updating an OpenStorage storage server to reflect plug-in updates
- NetApp storage configuration
- Importing existing NetApp relationships into the control of NetBackup

Partner requirements for a Replication Director environment

OpenStorage depends on the vendor storage that is exposed to NetBackup through a software plug-in that conforms to the Symantec OpenStorage API. In a NetBackup 7.5 Replication Director configuration, NetApp provides the storage.

For details on installing and configuring the following licenses, see the NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide, available from the NetApp Support Site.
### Table 2-1 NetApp hardware and software requirements for NetBackup Replication Director

<table>
<thead>
<tr>
<th>Device or software</th>
<th>Description and version</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>NetApp NAS file services are supported (CIFS and NFS). Available in a future release: ■ Block level device support (Fibre Channel, iSCSI) ■ Application support ■ Hypervisor support (VMware and Hyper-V)</td>
</tr>
<tr>
<td>NetApp hardware</td>
<td>NetApp FAS series filers. vFiler as source for SnapMirror and SnapVault is supported. NDMP must be enabled on both the primary and the secondary filers.</td>
</tr>
<tr>
<td>NetApp software</td>
<td>NetApp introduces support for Replication Director at the following software versions: ■ Data ONTAP 7.3.6 ■ OnCommand Core Package 5.0 The package includes DataFabric Manager server software (enabled by default) and the NetApp Management Console (install separately). ■ NetApp Plug-in for Symantec NetBackup Download the plug-in from the <a href="https://www.netapp.com/support/">NetApp Support Site</a>. The <em>NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide</em> is available from the <a href="https://www.netapp.com/support/">NetApp Support Site</a>. For more information about the plug-in versions that NetBackup supports, see the Replication Director section of the <a href="https://www.netapp.com/support/">Symantec NetBackup Hardware Compatibility List (HCL)</a>.</td>
</tr>
</tbody>
</table>

For NetBackup software and host requirements, see the following topic: See “NetBackup requirements for snapshots and snapshot replication” on page 25.

### Updating an OpenStorage storage server to reflect plug-in updates

If an OpenStorage partner updates their plug-in, update the NetBackup storage server to reflect the new functionality of the plug-in.

After you update the storage server, also update any existing disk pools. See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 58.
To update an OpenStorage storage server from the NetBackup Administration Console

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Servers.
2. In the right pane, right-click the storage server.
3. Select Update Storage Server Details.
4. Update the existing disk pools so that each can use the new functionality. Any disk pools that were created after the storage server is updated inherit the new functionality.

To update an OpenStorage storage server from the command line

1. Run the following command on the master server or on one of the media servers:

   ```
   nbdevconfig -updatests -storage_server storage_server
   -stype server_type -media_server media_server
   ```

   The following is the path to the nbdevconfig command:
   - UNIX: `/usr/openv/netbackup/bin/admincmd`
   - Windows: `install_path\NetBackup\bin\admincmd`

   See the following descriptions of the options that require arguments:

   `-storage_server storage_server`  The name of the disk appliance.

   `-stype server_type`  The storage vendor provides the string that identifies the server type.

   `-media_server media_server`  A NetBackup media server that connects to the storage server. The media server queries the storage server for its capabilities. The vendor plug-in must be installed on the media server. If the plug-in resides on more than one media server, you can specify any one of them.

2. Update the existing disk pools so that each can use the new functionality. Any disk pools that were created after the storage server is updated inherit the new functionality.
NetApp storage configuration

The storage administrator generally configures the volumes on the disk array. For example, the NetApp storage administrator divides the volumes into resource pools.

The storage administrator and the NetBackup administrator must work together to determine how the storage should to be apportioned to meet the company's data security objectives.

See the *NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide*, available from the NetApp Support Site, for details on preparing the NetApp configuration for use with Replication Director.

Importing existing NetApp relationships into the control of NetBackup

NetApp offers an import tool to migrate DataFabric Manager server datasets and Data ONTAP relationships into NetBackup. Once in NetBackup, the snapshot data can be managed using Replication Director.

The NetApp import tool allows the administrator to perform the following actions:

- Export the dataset configuration from the DataFabric Manager server into an XML file.
- Edit the XML file to change the backup policies or topology.
- Import the XML file into NetBackup.

For more information on the import tool, see the *NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide*, available from the NetApp Support Site.
NetBackup configuration

This chapter includes the following topics:

- NetBackup requirements for snapshots and snapshot replication
- NetBackup configuration
- NetBackup naming conventions

NetBackup requirements for snapshots and snapshot replication

OpenStorage is a Symantec API that allows NetBackup to communicate with the storage implementations that conform to the API.

Table 3-1 describes the required software and version for Replication Director.

Additional information appears in the following locations:

- See “Replication Director checklist” on page 11.
- NetBackup 7.x Operating System Compatibility List.

<table>
<thead>
<tr>
<th>Table 3-1</th>
<th>NetBackup software requirements for Replication Director</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Software and version</td>
</tr>
<tr>
<td>Master server requirements</td>
<td>NetBackup 7.5 software.</td>
</tr>
<tr>
<td></td>
<td>NetBackup OpenStorage Option, enabled with license key.</td>
</tr>
<tr>
<td></td>
<td>For more information, see the NetBackup OpenStorage Solutions Guide for Disk.</td>
</tr>
<tr>
<td></td>
<td>Snapshot Client option, enabled with license key.</td>
</tr>
</tbody>
</table>
Table 3-1  NetBackup software requirements for Replication Director (continued)

<table>
<thead>
<tr>
<th>Host</th>
<th>Software and version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media server requirements</td>
<td>On each media server that can access the disk array:</td>
</tr>
<tr>
<td></td>
<td>■ NetBackup 7.5 software</td>
</tr>
<tr>
<td></td>
<td>■ NetBackup 7.5 OpenStorage Option, enabled with license key.</td>
</tr>
<tr>
<td></td>
<td>■ NetBackup 7.5 Enterprise Disk Option, enabled with license key.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The master server and media server can reside on the same server.</td>
</tr>
<tr>
<td>Client</td>
<td>NetBackup 7.5 client software.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Virtual machines must have a NetBackup client installed on the machine.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> vStorage and Hyper-V backup policies are not supported.</td>
</tr>
</tbody>
</table>

NetBackup configuration

NetBackup configuration is performed by the NetBackup administrator, as described in Table 3-2.

Table 3-2  NetBackup configuration tasks overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Reference topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install or upgrade NetBackup software on the master server and media server(s).</td>
<td>See “NetBackup requirements for snapshots and snapshot replication” on page 25.</td>
</tr>
<tr>
<td>2</td>
<td>Run the Storage Server Configuration Wizard to configure the OpenStorage partner as a NetBackup storage server. (For example, configure the DataFabric Manager server as a storage server.) Also configured as part of this wizard are the following:</td>
<td>See “Creating a NetBackup storage server for snapshot replication” on page 29.</td>
</tr>
<tr>
<td></td>
<td>■ Specify media servers that can access the storage server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Create a disk pool that contains the primary snapshot.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Create a storage unit for the primary disk pool.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>Reference topic</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>3</td>
<td>Create an additional disk pool for every group of disk volumes that will contain snapshot replications of the primary snapshot. As part of the Disk Pool Creation Wizard, also configure a storage unit for each disk pool.</td>
<td>See “Creating disk pools for snapshot replication” on page 50.</td>
</tr>
<tr>
<td>4</td>
<td>Create a storage unit for any operation that will produce duplications (non-snapshot copies).</td>
<td>See “Creating a storage unit” on page 73.</td>
</tr>
<tr>
<td>5</td>
<td>Configure a storage lifecycle policy. Create a new operation in the SLP for each task that the SLP is to perform. For example, create a Snapshot operation to perform the initial snapshot and a Replication operation to create a copy of the snapshot. Other operation types are available.</td>
<td>See “Creating a storage lifecycle policy for snapshots and snapshot replication” on page 81.</td>
</tr>
<tr>
<td>6</td>
<td>Configure a NetBackup policy to perform all of the operations indicated in the SLP. To do so, the Policy storage selection in the policy must indicate the SLP that is configured for snapshots and snapshot replication.</td>
<td>See “Configuring a policy for use with Replication Director” on page 105. See “Configuring a policy to use NDMP with Replication Director” on page 114. <strong>Note:</strong> Do not use the Policy Configuration Wizard or the Getting Started Wizard to configure policies for Replication Director.</td>
</tr>
</tbody>
</table>

The following figure is an overview of how the NetBackup components fit together to perform snapshots and snapshot replication. The following sections describe how to configure each part of this process.
Figure 3-1  How NetBackup uses NetApp storage

Storage is presented to NetBackup as volumes.

Use the Storage Server Configuration Wizard to group volumes into disk pools, and then into storage units.

An SLP points to the snapshot-capable storage units as snapshot and snapshot replication destinations.

A backup policy requests a snapshot of client data. Policy points to the SLP as storage for snapshots.

NetBackup naming conventions

The following set of characters can be used in user-defined names, such as disk pools and storage lifecycle policies:

- Alphabetic (A-Z a-z) (names are case sensitive)
- Numeric (0-9)
- Period (.)
- Plus (+)
- Minus (-)
  - Do not use a minus as the first character.
- Underscore (_)

Note: No spaces are only allowed.
This chapter includes the following topics:

- Creating a NetBackup storage server for snapshot replication
- Adding the storage server credentials to a NetBackup server
- Deleting an OpenStorage storage server

Creating a NetBackup storage server for snapshot replication

A NetBackup storage server is a NetBackup entity that has exclusive access to manage snapshots on the volumes of an OpenStorage partner.

For example, with NetApp as an OpenStorage partner, the NetApp DataFabric Manager server must be configured to be the NetBackup storage server. A NetBackup domain can contain only one DataFabric Manager server.

To gain access to the disk volumes of the OpenStorage partner, you must configure a NetBackup storage server by running the **Storage Server Configuration Wizard**.

In addition to creating a storage server, this wizard also includes steps for configuring disk pools and storage units. Both are required for snapshots and snapshot replication.
To create a storage server

1. Before launching the wizard, make sure that the OpenStorage partner has the necessary software installed and is online. The volumes of the array must also be configured.

2. To start the **Storage Server Configuration Wizard**, click **Configure Disk Storage Servers** in the **NetBackup Administration Console** main window.

3. Select **OpenStorage** as the disk storage type to be configured in this wizard. Click **Next**.

4. Define the storage server type and configure the credentials for the storage server.
Creating a NetBackup storage server for snapshot replication

Add Storage Server

Provide details to create storage server

Storage server name: DFM_server_name

Storage Server Type

- Use Symantec's OpenStorage plugin for network-controlled storage server

Storage server type: Network

NTAP

Media Server

Select a media server that has the vendor's OpenStorage plugin installed. NetBackup will query the storage server for its capabilities by sending the probe through the media server you specify.

Select media server: bitum/vm2

Enter credentials:

- User name: root

- Password: password

- Confirm password: password

< Back  Next  >  Cancel  Help
Enter the name of the storage server. You must enter the exact name of the storage server, whether fully-qualified or short. (For OpenStorage partner NetApp, this is the name of the DataFabric Manager.)

Use the `bpstsinfo` command, located in the following directory, to determine the exact storage server name:

- **UNIX and Linux systems:** `/usr/openv/netbackup/bin/admincmd/`
- **Windows:** `Install_path\NetBackup\bin\admincmd`

Enter the `bpstsinfo` command as follows:

```
bpstsinfo -serverinfo -storage_server
known_storage_server_name -stype storage_server_type
```

For example, to ensure that the name of the DataFabric Manager server is *chania*, enter the following command and locate the storage server name in the output:

```
bpstsinfo -serverinfo -storage_server chania -stype Network_NTAP
```

Use the storage server name that is indicated in the output.

If the name entered in this dialog box does not match the actual name of the storage server, a status code 1552 results during SLP validation.

To use the Replication Director, enable the **Use Symantec's OpenStorage plug-in for network-controlled storage server** check box.

Once the check box is enabled, the **Network** prefix appears in front of the **Storage server type** field.

Enter the storage type suffix, which is vendor-specific and case-sensitive.

For example, if the OpenStorage partner is NetApp, type *NTAP* as the **Storage server type**.

The entire name (prefix and suffix), is the name that is saved in the NetBackup EMM database. For example, **Network_NTAP**.
Media server
Select the media server to use to query the storage server. Note that all of the media servers in the configuration appear in the list, even if the OpenStorage plug-in is not installed. Select a media server where the OpenStorage plug-in is installed.

The selected media server is assigned the credentials for the storage server. Credentials allow the media server to communicate with the storage server.

- Enter the user name to logon to the storage host.
  For example, if the OpenStorage partner is NetApp, the credentials are used to log in to the DataFabric Manager server.
  If the storage host does not require logon credentials, enter dummy credentials.
- Enter the password for the logon account.
- Re-enter the password to confirm the password.

For a media server to communicate with and have access to a storage server, it must be added to the Replication Director environment.

See “Adding the storage server credentials to a NetBackup server” on page 44.

Click Next.

5 The Configure Additional Media Servers panel appears in environments where there are multiple media servers or where the master server is on a different host from the media server.

- Enable the checkboxes for all media servers that are to be used to access the storage server for snapshots, snapshot replication, or restores.

- Enable the checkbox for the computer that hosts the master server, if it appears in the list. The master server host must be enabled so that the NetBackup catalog is updated correctly for rollback and restore operations.

Note: The master server does not appear in the list if it was already selected in the Add Storage Server wizard pane as a media server for the Select media server property (4).
6 The wizard displays a summary panel that lists the configuration information that you’ve entered. Click **Next**.

7 The wizard displays a panel that contains the creation status of the storage server. Click **Next**.

![Storage Server Configuration Wizard](image)

---

**Storage Server Creation Status**

Performing required task for storage server creation.

Please wait while the wizard completes the following tasks:

<table>
<thead>
<tr>
<th>Status</th>
<th>Performing task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Creating storage server DFM_server_name...</td>
<td></td>
</tr>
<tr>
<td>✔</td>
<td>Adding credentials for server bituevm3...</td>
<td></td>
</tr>
</tbody>
</table>
The wizard declares that the storage server was successfully created. Click Next to launch the Disk Pool Configuration Wizard. A disk pool is necessary for snapshots and snapshot replication.

**Note:** If the Disk Pool Configuration Wizard does not launch automatically, click Configure Disk Pool in the NetBackup Administration Console to start the wizard manually.

In the Disk Pool Configuration Wizard welcome panel, click Next.

Select the type of disk pool that you want to create. For example, to configure an OpenStorage disk pool for the OpenStorage partner NetApp, select OpenStorage (Network_NTAP). If an OpenStorage partner does not appear for selection, make sure that the license has been installed and that an OpenStorage storage server has been created.
11 On the **Select Storage Server** panel, select the storage server that was created earlier in the wizard. Click **Next**.
12 The Select Disk Pool Properties and Volumes panel presents all of the volumes that have been configured in the storage of the OpenStorage partner by the storage administrator.

A disk pool can contain only those volumes that share similar properties. So that dissimilar volumes are not combined, NetBackup filters the volumes for selection.

Select the Primary property to configure the first disk pool for snapshots. The list displays all of the volumes that match the selected property.

The primary volume is always a source as well.

The primary volume displays the available space and total space as 0.

Note: For primary volumes, the dialog always displays the total sizes as 0 bytes.

13 Select a primary volume in the table to be part of this first disk pool. Notice that primary volumes also have the Source property set as well. Snapshots on the primary volume are the source for snapshot replication. Click Next.
14 In the **Disk Pool Properties** panel, name the disk pool and add any comments you want to make regarding the disk pool.

See "**NetBackup naming conventions**" on page 28.

The available size that is listed is the total amount of space available in the pool. The raw size is the total raw, unformatted size of the storage in the disk pool.

Enable **Limit I/O streams** to limit the number of read and write streams (jobs) for each volume in the disk pool. Select the number of read and write streams to allow per volume. When the limit is reached, NetBackup chooses another volume for write operations, if available. If not available, NetBackup queues jobs until a volume is available.

Click **Next**.
The disk pool summary panel displays the storage server configuration up to this point. The summary describes the following details about the proposed disk pool:

- The storage server name.
- The storage server type. (For example, Network_NTAP.)
- The names of the volumes in this disk pool.
- The disk pool name.
- Whether the disk pool is configured to contain snapshots.
- The properties of the volumes in the disk pool: **Primary** and **Source**.
- The Maximum I/O streams, if configured.
- Any comments, if configured.

Click **Next** to configure the disk pool.
The wizard announces the successful creation of the disk pool. Click Next.
17 After the disk pool creation completes, create a storage unit that uses the new disk pool. A storage unit that uses this disk pool is necessary for snapshots.

Select **Create a storage unit that uses New disk pool name** and click **Next**.
18 In the **Storage Unit Creation** panel, name the storage unit.

See “**NetBackup naming conventions**” on page 28.

Select the media server(s) that can use the storage unit.

- **Use any available media server to transport data.** NetBackup selects any media server to access the storage unit.
- **Use only the selected media servers.** NetBackup uses only the media server that is specified to access the storage unit.

Only media servers that have the OpenStorage plug-in installed appear in this list. For a media server to communicate with and have access to a storage server, it must be added to the Replication Director environment.

See “**Adding the storage server credentials to a NetBackup server**” on page 44.

**Note:** A storage unit can represent many physical devices. When a storage unit is a replication target, NetBackup lets the plug-in select which device to use within the storage unit. For replication jobs, storage units and storage unit groups ignore the **Maximum concurrent jobs** setting. NetBackup does not attempt to throttle the parameters.
19 Click Next. The final wizard panel displays, announcing that the wizard has been completed.

You've just configured a storage server, a disk pool, and a storage unit to contain the primary snapshots. Configure additional disk pools (and storage units) for every group of disk volumes that will contain snapshot replications of the primary snapshots.

For example, in the following figure, two disk pools are necessary:

- One disk pool that contains volumes to hold primary snapshots and act as a source for other replications, and
- a second disk pool that contains volumes that are replication targets for snapshot replications.
See the following topic for more information about creating more disk pools and storage units.

See “Creating disk pools for snapshot replication” on page 50.

Adding the storage server credentials to a NetBackup server

Use the following procedure to add the storage server credentials to a NetBackup server in a Replication Director environment.

Note: If you add or change credentials, ensure that the computer that hosts the master server is always selected.

To add OpenStorage server credentials

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Servers.
2. Select the storage server, then select Edit > Change.
3. Select the Media Servers tab.
4. Select the server you want to add. Also ensure that any servers already credentialed are selected.
5. Enter the credentials.
6. Click Set and then click OK.

Deleting an OpenStorage storage server

If you delete a storage server, NetBackup removes it from your configuration.
Warning: Do not delete a storage server if the storage that it manages contains unexpired NetBackup images.

To delete an OpenStorage storage server

1. If the storage server currently manages volumes, perform the following tasks:
   - Expire the images on the volumes.
      
      Warning: If unexpired images are deleted, data loss may occur.
   - Delete the storage units that comprise the disk pools.
   - Delete the disk pools.

2. In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Credentials > Storage Servers

3. Select the storage server that you want to delete.

4. On the Edit menu, select Delete.

5. Click Yes in the confirmation dialog box.
Configuring disk pools for snapshot and replication

This chapter includes the following topics:

■ About disk pools for snapshots and snapshot replication
■ Creating disk pools for snapshot replication
■ Updating disk pools after volumes are added, are deleted, or are changed
■ Updating an OpenStorage disk pool to reflect plug-in updates
■ How to resolve snapshot disk volume changes
■ Using bpsstinfo to view the replication topology of the device

About disk pools for snapshots and snapshot replication

An OpenStorage disk pool represents the disk storage that is exposed to NetBackup through the OpenStorage API. A disk pool can represent one or more volumes. Disk pools inherit their properties from the volumes that comprise the disk pools.

Snapshot and snapshot replication disk pools differ from other NetBackup disk pool types as follows:

■ Only one storage unit can access a snapshot or snapshot replication disk pool.
■ Snapshot and snapshot replication disk pools observe no high and low water marks.

One disk pool to be used for snapshots can be configured as part of the Storage Server Configuration Wizard. At least one additional disk pool is necessary for
snapshot replication. The Disk Pool Configuration Wizard can also be launched independently.

See “Creating disk pools for snapshot replication” on page 50.

The NetBackup administrator creates multiple disk pools to serve specific purposes in a replication configuration. The volumes in a disk pool must have properties that match their intended purpose.

For example, the following disk pools are necessary to create a snapshot volume and replicate it to target volumes:

- A disk pool that contains a volume where the initial snapshot can be created. The volume must have the **Snapshot** and **Primary** attributes set. See “Primary + Replication source snapshot storage unit” on page 89.

- A disk pool that contains a volume with the **Snapshot** and the **Replication target** properties set to serve as the target for a replica snapshot. See “Replication target snapshot storage unit” on page 90.

The following topic describes the roles that disk pools and storage units can serve in a Replication Director configuration:

See “About configuring storage lifecycle policies for snapshots and snapshot replication” on page 79.

### About disk volumes for snapshots and snapshot replication

For snapshots and snapshot replication, all of the volumes in a disk pool must be homogeneous; that is, they must have the same properties. The NetBackup Disk Pool Configuration Wizard enforces compliance, as does the Change Disk Pool dialog box.

The storage administrator defines the properties and the replication topology of the disk volumes. The NetBackup administrator creates disk pools, based on the properties of the volumes.

- The volume properties define in what capacity the volumes can be used:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Snapshot</strong></td>
<td>The default property. All volumes that are used for snapshots or snapshot replication must have this property.</td>
</tr>
<tr>
<td><strong>Primary</strong></td>
<td>The volume can be used for snapshot creation.</td>
</tr>
<tr>
<td><strong>Replication source</strong></td>
<td>The volume can be used as a source for replicating snapshots.</td>
</tr>
<tr>
<td><strong>Replication target</strong></td>
<td>The volume can be used as a target for snapshot replication.</td>
</tr>
</tbody>
</table>
The volume is a mirror for snapshots. Mirror snapshots have the same life span as the original snapshot.

- The replication topology defines the source and the target volumes for replication. For example, volume S1 replicates to T1, volume S2 replicates to T2, and so on. When you configure your NetBackup disk pools, add the source volumes (Sn) to the disk pool you use for snapshot creation. Then, add the target volumes (Tn) to the disk pool that is the target of the replication.

- The **Disk Pool Configuration Wizard** may not display all of the properties, depending on the underlying volumes.

- For example, if a SnapMirror relationship is not defined at the volume layer, then the **Mirror** property does not appear in the wizard panel for selection.

Table 5-1 shows the properties that are required for snapshots and snapshot replication volumes, depending on their intended purpose in the NetBackup snapshot and snapshot replication process.

### Table 5-1   Purpose of volume and required volume properties

<table>
<thead>
<tr>
<th>Purpose of volume</th>
<th>Snapshot property</th>
<th>Primary property</th>
<th>Replication source property</th>
<th>Replication target property</th>
<th>Mirror property</th>
</tr>
</thead>
<tbody>
<tr>
<td>A volume to contain the initial snapshots of primary data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>A primary volume is always a replication source as well.</td>
</tr>
<tr>
<td>A volume to serve as a replication source or a replication target.</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>The <strong>Source</strong> property allows the volume to serve as a source for snapshot copies.</td>
</tr>
</tbody>
</table>

A target volume may be have the **Mirror** property enabled or be **Independent**.

See “About disk pools for snapshots and snapshot replication” on page 47.
See “How to resolve snapshot disk volume changes” on page 58.
Creating disk pools for snapshot replication

One disk pool can be configured as part of the Storage Server Configuration Wizard to contain primary snapshots. Additional disk pools are necessary for snapshot replication.

Run the Disk Pool Configuration Wizard after running the `bpstsinfo` command. The output from the command is necessary to view the replication properties of the volumes and understand which volumes to include in the various disk pools.

See “Using bpstsinfo to view the replication topology of the device” on page 65.

To create a disk pool

1. Select Media and Device Management. In the right pane, click Configure Disk Pool.
2. In the Disk Pool Configuration Wizard welcome panel, click Next.
3. Select the type of disk pool that you want to create. For example, to configure an OpenStorage disk pool for the OpenStorage partner NetApp, select OpenStorage (Network_NTAP).
4 On the Select Storage Server panel, select the storage server. Click Next.
5 The Select Disk Pool Properties and Volumes panel presents all of the volumes that have been configured in the storage of the OpenStorage partner by the storage administrator.

You've already created one disk pool as part of the Storage Server Configuration Wizard. It was configured to contain primary snapshots that can serve as a source for replication. Now create a disk pool that can serve as a replication target.

To create a disk pool that is a target for replication, select Replication target. NetBackup filters the volumes for selection so that dissimilar volumes are not combined.

Note that in the Replication column, all the volumes have both Source and Target properties. That means that the volume can serve as both a target for replications as well as a source for another replication.

Expand the column to display other properties of the volume. For example, whether the volume is configured to be a mirror.
Another method to filter the volumes is to first clear the Primary, Replication source, and Replication target properties. Then, click on a specific volume. The wizard panel filters the volumes, displaying only those volumes that match the properties of the selected volume.

6 Select the volume(s) to be part of this disk pool. Click Next.
7  In the **Additional Disk Pool Information** panel, name the disk pool.

See “**NetBackup naming conventions**” on page 28.

The available size that is listed is the total amount of space available in the pool. The raw size is the total raw, unformatted size of the storage in the disk pool. Click **Next**.

8  The disk pool summary panel displays the storage server configuration up to this point.

Click **Next** to configure the disk pool.

9  The wizard announces the successful creation of the disk pool. Click **OK**.
10 After the disk pool creation completes, create a storage unit that uses the new disk pool. A storage unit that uses this disk pool is necessary for snapshot replication.

Select Create a storage unit that uses New disk pool name and click Next.

11 In the Storage Unit Creation panel, name the storage unit.

Select the media server(s) that can use the storage unit.

- **Use any available media server to transport data.** NetBackup selects any media server to access the storage unit.
- **Use only the selected media servers.** NetBackup uses only the media server that is specified to access the storage unit.

Only media servers that have the OpenStorage plug-in installed appear in this list. For a media server to communicate with and have access to a storage server, it must be added to the Replication Director environment.

12 Click Next. The final wizard panel displays, announcing that the wizard has been completed.

Configure additional disk pools (and storage units) for every group of disk volumes that will contain snapshot replications of the primary snapshots.

### Updating disk pools after volumes are added, are deleted, or are changed

The storage administrator may change the properties of the volumes in a way that affects the topology of the volumes. If these volumes are used in a Replication Director environment, the changes may affect the capabilities of the disk pool. For example, a volume change may make a volume in the disk pool no longer usable by NetBackup.

If volume properties change, you must update the disk pools to which those volumes belong. Depending on the volume changes, you may also have to change storage units, storage unit groups, and storage lifecycle policies.
To update the volumes in a disk pool after the storage changes

1. In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Devices > Disk Pools.

2. In the right pane, select the disk pool you want to update.

3. Click Edit > Change.
4 In the **Change Disk Pool** dialog box, click **Refresh** to query the disk array for new, deleted, or changed volumes.

5 NetBackup communicates volume changes in the following manner:

- If a new volume was added, the volume appears in the list. It may be eligible to be added to the disk pool.
- If volumes have been deleted, or changed, or are no longer homogenous, see the following topic:
  See “**How to resolve snapshot disk volume changes**” on page 58.
Updating an OpenStorage disk pool to reflect plug-in updates

If an OpenStorage partner updates their plug-in, update the existing disk pools to reflect the new functionality of the plug-in after you update the NetBackup storage server.

Any disk pools that are created after the storage server is updated inherit the new functionality.

To update an OpenStorage disk pool to reflect plug-in updates

Run the following command on the master server:

```
nbdevconfig -changedp -dp disk_pool_name -stype server_type -setattribute attribute
```

The following is the path to the `nbdevconfig` command:

- UNIX: `/usr/openv/netbackup/bin/admincmd`
- Windows: `install_path\NetBackup\bin\admincmd`

See the following descriptions of the options that require arguments:

- `-changedp` `disk_pool_name`
  The name of the disk pool.

- `-stype` `server_type`
  The storage vendor provides the string that identifies the server type.

- `-setattribute` `attribute`
  The `attribute` is the name of the argument that represents the new functionality.

For example, `OptimizedImage` specifies that the environment supports the optimized synthetic backup. `SpanImages` specifies that backup images can span across volumes on the disk appliance.

How to resolve snapshot disk volume changes

Symantec recommends that you take the following actions when volume properties or topology change:

- Discuss the changes with the storage administrator. You need to understand the changes so you can change your disk pools (if required) so that NetBackup can continue to use them.
If the changes were unplanned, request that the changes be reverted so that NetBackup functions correctly again.

NetBackup can process changes to the following volume properties:

- Primary
- Replication Source
- Replication Target

If these volume properties change, NetBackup can update the disk pool to match the changes. NetBackup can continue to use the disk pool, although the disk pool may no longer match the storage unit or storage lifecycle purpose.

When you open the **Change Disk Pool** dialog box, NetBackup loads the disk pool properties from the catalog. NetBackup only queries the storage server for changes when you click the **Refresh** in the **Change Disk Pool** dialog box.

**Table 5-2** describes the possible outcomes and describes how to resolve them.

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No changes are discovered.</td>
<td>No changes are required.</td>
</tr>
<tr>
<td>NetBackup discovers the new volumes that match the disk pool</td>
<td>The new volumes appear in the <strong>Change Disk Pool</strong> dialog box. Text in the dialog box changes to indicate that you can add the new volumes to the disk pool.</td>
</tr>
</tbody>
</table>

Table 5-2 Refresh outcomes
### Table 5-2 Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
</table>
| The replication properties of all of the volumes changed, but they are still consistent. | A **Disk Pool Configuration Alert** pop-up box notifies you that the properties of all of the volumes in the disk pool changed, but they are all the same (homogeneous). You must click **OK** in the alert box, after which the disk pool properties in the **Change Disk Pool** dialog box are updated to match the new volume properties. If new volumes are available that match the new properties, NetBackup displays those volumes in the **Change Disk Pool** dialog box. You can add those new volumes to the disk pool. In the **Change Disk Pool** dialog box, select one of the following two choices:  
  - **OK**. To accept the disk pool changes, click **OK** in the **Change Disk Pool** dialog box. NetBackup saves the new properties of the disk pool. NetBackup can use the disk pool, but it may no longer match the intended purpose of the storage unit or storage lifecycle policy. Change the storage lifecycle policy definitions to ensure that the replication operations use the correct source and target disk pools, storage units, and storage unit groups.  
  - **Cancel**. To discard the changes, click **Cancel** in the **Change Disk Pool** dialog box. NetBackup does not save the new disk pool properties. NetBackup can use the disk pool, but it may no longer match the intended use of the storage unit or storage lifecycle policy. |
### Table 5-2  Refresh outcomes *(continued)*

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The replication properties of the volumes changed, and they are now inconsistent.</td>
<td>A <strong>Disk Pool Configuration Error</strong> pop-up box notifies you that the replication properties of some of the volumes in the disk pool changed. The properties of the volumes in the disk pool are not homogeneous. A <strong>Disk Pool Configuration Error</strong> pop-up box notifies you that the replication properties of some of the volumes in the disk pool changed. The properties of the volumes in the disk pool are not homogeneous. You must click <strong>OK</strong> in the alert box. In the <strong>Change Disk Pool</strong> dialog box, the properties of the disk pool are unchanged, and you cannot select them (that is, they are dimmed). However, the properties of the individual volumes are updated. Because the volume properties are not homogeneous, NetBackup cannot use the disk pool until the storage configuration is fixed. NetBackup does not display new volumes (if available) because the volumes already in the disk pool are not homogeneous. To determine what has changed, compare the disk pool properties to the volume properties. Work with your storage administrator to change the volume properties back to their original values. The disk pool remains unusable until the properties of the volumes in the disk pool are homogenous. In the <strong>Change Disk Pool</strong> dialog box, click <strong>OK</strong> or <strong>Cancel</strong> to exit the <strong>Change Disk Pool</strong> dialog box.</td>
</tr>
</tbody>
</table>
### Table 5-2

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The snapshot properties changed.</td>
<td>A <strong>Disk Pool Configuration Error</strong> pop-up box notifies you that the snapshot properties of some of the volumes in the disk pool changed.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Disk Pool Configuration Error" /></td>
</tr>
<tr>
<td></td>
<td>You must click <strong>OK</strong> in the alert box.</td>
</tr>
<tr>
<td></td>
<td>In the <strong>Change Disk Pool</strong> dialog box, the properties of the disk pool are unchanged, and you cannot select them (that is, they are dimmed). However, the properties of the individual volumes are updated.</td>
</tr>
<tr>
<td></td>
<td>Because the volume properties are not homogeneous, NetBackup cannot use the disk pool until the storage configuration is fixed.</td>
</tr>
<tr>
<td></td>
<td>NetBackup does not display new volumes (if available) because the volumes already in the disk pool are not homogeneous.</td>
</tr>
<tr>
<td></td>
<td>To determine what has changed, compare the disk pool properties to the volume properties. Work with your storage administrator to change the volume properties back to their original values.</td>
</tr>
<tr>
<td></td>
<td>The disk pool remains unusable until the properties of the volumes in the disk pool are homogenous.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>OK</strong> or <strong>Cancel</strong> to exit the <strong>Change Disk Pool</strong> dialog box.</td>
</tr>
</tbody>
</table>
### Table 5-2 Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The replication topology</td>
<td>A <strong>Disk Pool Configuration Alert</strong> pop-up box notifies you that the replication topology changed.</td>
</tr>
<tr>
<td>changed.</td>
<td><strong>Disk Pool Configuration Alert</strong></td>
</tr>
<tr>
<td></td>
<td>The replication topology of existing volumes has changed.</td>
</tr>
<tr>
<td></td>
<td>The changed disk pool may differ from its original use in the storage unit or storage lifecycle policy.</td>
</tr>
<tr>
<td></td>
<td>Verify that the disk pool matches the intended purpose of the storage unit or storage lifecycle policy.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Disk Pool Configuration Alert" /></td>
</tr>
<tr>
<td></td>
<td>OK</td>
</tr>
</tbody>
</table>

You must click **OK** in the alert box.

If NetBackup also discovers the new volumes that match the replication properties, they are displayed in the dialog box. You can add those new volumes to the disk pool.

Work with your storage administrator to understand the topology changes. Alternatively, use the `bpstsinfo -lsuinfo` command to discover the current topology. Compare the new topology to the previous topology.

See “Using `bpstsinfo` to view the replication topology of the device” on page 65.

In the **Change Disk Pool** dialog box, select one of the following two choices:

- **OK.** To accept the disk pool changes, click **OK** in the **Change Disk Pool** dialog box. NetBackup saves the new properties of the disk pool. NetBackup can use the disk pool, but it may no longer match the intended purpose of the storage unit or storage lifecycle policy. Change the storage lifecycle policy definitions to ensure that the replication operations use the correct source and target disk pools, storage units, and storage unit groups.

- **Cancel.** To discard the changes, click **Cancel** in the **Change Disk Pool** dialog box. NetBackup does not save the new disk pool properties. NetBackup can use the disk pool, but it may no longer match the intended use of the storage unit or storage lifecycle policy.
Table 5-2  Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
</table>
| The replication topology changed and the replication properties of the volumes in the disk pool changed. | A **Disk Pool Configuration Alert** pop-up box notifies you that the replication topology changed and all of the replication properties of all of the volumes in the disk pool changed. The new properties are all the same (homogeneous). You must click **OK** in the alert box. In the **Change Disk Pool** dialog box, the properties of the disk pool are updated to show the new properties. You cannot select the properties (that is, they are dimmed). If new volumes are available that match the new properties, NetBackup displays those properties in the **Change Disk Pool** dialog box. You can add those new volumes to the disk pool. Work with your storage administrator to understand the topology changes. Alternatively, use the `bpstatsinfo -lsuinfo` command to discover the current topology. Compare the new topology to the previous topology. See “**Using bpstatsinfo to view the replication topology of the device**” on page 65. In the **Change Disk Pool** dialog box, select one of the following two choices:  
  ■ **OK**. To accept the disk pool changes, click **OK** in the **Change Disk Pool** dialog box. NetBackup saves the new properties of the disk pool. NetBackup can use the disk pool, but it may no longer match the intended purpose of the storage unit or storage lifecycle policy. Change the storage lifecycle policy definitions to ensure that the replication operations use the correct source and target disk pools, storage units, and storage unit groups.  
  ■ **Cancel**. To discard the changes, click **Cancel** in the **Change Disk Pool** dialog box. NetBackup does not save the new disk pool properties. NetBackup can use the disk pool, but it may no longer match the intended use of the storage unit or storage lifecycle policy. |

---
### Table 5-2  Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBackup cannot find a volume or volumes that were in the disk pool.</td>
<td>A <strong>Disk Pool Configuration Alert</strong> pop-up box notifies you that an existing volume or volumes was deleted from the storage device:</td>
</tr>
</tbody>
</table>

#### Disk Pool Configuration Alert

An existing volume in this disk pool cannot be found on the storage device and is no longer available to NetBackup.
The volume might be offline or deleted. If deleted, any data on that volume is lost.

Volume(s) deleted: StopVault

Refer to documentation for information on how to resolve this issue.

| | OK |

NetBackup can use the disk pool, but data may be lost.
To protect against accidental data loss, NetBackup does not allow volumes to be deleted from a disk pool.
To continue to use the disk pool, do the following:

- Use the `bpimmedia` command or the Images on Disk report to display the images on the specific volume.
- Expire the images on the volume.
- Use the `nbdevconfig` command to set the volume state to DOWN so NetBackup does not try to use it.

### Using `bpstsinfo` to view the replication topology of the device

For a replication operation to succeed, a volume which is a source of replication must have a replication partner which is the target of replication. The replication relationship between volumes is provided to NetBackup by the storage device using the OpenStorage APIs.

To understand the replication topology of the storage server, run the `bpstsinfo` command, specifying the storage server name and the OpenStorage server type. For example:

```
bpstsinfo -lsuinfo -storage_server storage_server_name -stype network_type
```

The command is located in the following directory:

- UNIX and Linux systems:
  
  ```bash
  /usr/openv/netbackup/bin/admincmd/
  ```
Windows:

\texttt{Install\_path\NetBackup\bin\admincmd}\n
The output from the \texttt{bpstsinfo} command displays the following information:

- The name of the storage server (\texttt{Server Name}). The storage server name here must be the same as the storage server name used in the \texttt{Storage Server Configuration Wizard}.
- The name of the volume (\texttt{LSU Name}).
- The properties of the volume (\texttt{Media, Save As}).
- The replication sources of the volume (\texttt{Replication Sources}).
- The replication targets of the volume (\texttt{Replication Targets}).

Save the output to a file so that you can compare the current topology with the previous topology to determine what has changed.

Sample \texttt{bpstsinfo} output

The following examples show sample output from the \texttt{bpstsinfo} command for a NetApp storage server named \texttt{plinko} which contains four LSUs. The generic syntax for the command is as follows:

\texttt{bpstsinfo \textcolor{red}{-lsuinfo} \textcolor{red}{-storage\_server <storage\_server\_name>} \textcolor{red}{-stype <storage\_type>}}

The following is an example of the command, run on the NetBackup media server, for storage server \texttt{plinko}:

\texttt{bpstsinfo \textcolor{red}{-lsuinfo} \textcolor{red}{-storage\_server plinko} \textcolor{red}{-stype Network\_NTAP}}

Output for first LSU:

\texttt{LSU Info:}

\begin{verbatim}
    Server Name: Network\_NTAP:plinko
    LSU Name: PrimarySnapshot
    Allocation : STS\_LSU\_AT\_STATIC
    Storage: STS\_LSU\_ST\_NONE
    Description:
    Configuration:
    Media: (STS\_LSUF\_REP\_ENABLED | STS\_LSUF\_REP\_SOURCE)
    Save As : (STS\_SA\_PRIMARY | STS\_SA\_SNAPSHOT)
    Replication Sources: 0 ( )
\end{verbatim}
The `bpstsinfo` output provides the following information about the volume:

<table>
<thead>
<tr>
<th>Storage server name (Server Name)</th>
<th>plinko</th>
</tr>
</thead>
<tbody>
<tr>
<td>The name preceding the server name is the storage server type. For example, Network_NTAP.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Volume name (LSU Name)</th>
<th>PrimarySnapshot</th>
</tr>
</thead>
<tbody>
<tr>
<td>The volume has the following properties:</td>
<td></td>
</tr>
<tr>
<td>■ Primary</td>
<td></td>
</tr>
<tr>
<td>■ Snapshot</td>
<td></td>
</tr>
<tr>
<td>■ Replication Source</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Volume properties (Media, Save As)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The volume has no replication sources. It cannot receive replication from any other volume.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Replication sources of the volume (Replication Sources)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The volume has three replication targets.</td>
</tr>
<tr>
<td>It can replicate to the following volumes:</td>
</tr>
<tr>
<td>■ Netapp3140a2_SnapVault</td>
</tr>
<tr>
<td>■ Netapp3140a2_SnapMirror</td>
</tr>
<tr>
<td>■ Netapp3140a2_SecondSnapMirror</td>
</tr>
</tbody>
</table>

### Output for second LSU:

**LSU Info:**

Server Name: Network_NTAP:plinko
LSU Name: Netapp3140a2_SnapVault
Allocation: STS_LSU_AT_STATIC
Storage: STS_LSU_ST_NONE
Description:
Configuration:
Media: (STS_LSUF_REP_ENABLED | STS_LSUF_REP_SOURCE | STS_LSUF_REP_TARGET | STS_LSUF_MIRROR_FLEXIBLE)
Save As: (STS_SA_SNAPSHOT | STS_SA_MIRROR)
Replication Sources: 3 (Network_NTAP:plinko:PrimarySnapshot Network_NTAP:plinko:Netapp3140a2_SnapMirror Network_NTAP:plinko:Netapp3140a2_SecondSnapMirror)
Replication Targets: 2 (Network_NTAP:plinko:Netapp3140a2_SnapMirror Network_NTAP:plinko:Netapp3140a2_SecondSnapMirror)
The `bpstsinfo` output provides the following information about the volume:

**Storage server name (Server Name).**

plinko

The name preceding the server name is the storage server type.

**Volume name (LSU Name).**

Netapp3140a2_SnapVault

**Volume properties (Media, Save As).**

The volume has the following properties:

- Snapshot
- ReplicationSource
- ReplicationTarget
- Mirror
- MirrorFlexible

Since the LSU is MirrorFlexible, it can be configured as Mirror-capable or not Mirror-capable as specified by the user.

**Replication sources of the volume (Replication Sources).**

The volume has three replication sources.

It can receive replications from the following three volumes:

- PrimarySnapshot
- Netapp3140a2_SnapMirror
- Netapp3140a2_SecondSnapMirror

**Replication targets of the volume (Replication Targets).**

The volume has two replication targets.

It can replicate to the following two volumes:

- Netapp3140a2_SnapMirror
- Netapp3140a2_SecondSnapMirror

**Output for third LSU:**

**LSU Info:**

Server Name: Network_NTAP:plinko
LSU Name: Netapp3140a2_SnapVault
Allocation: STS_LSU_AT_STATIC
Storage: STS_LSU_ST_NONE
Description: 
Configuration: 
Media: (STS_LSUF_REP_ENABLED | STS_LSUF_REP_SOURCE |
Output for fourth LSU:

LSU Info:
Server Name: Network_NTAP:plinko
LSU Name: Netapp3140a2_SecondSnapMirror
Allocation: STS_LSU_AT_STATIC
Storage: STS_LSU_ST_NONE
Description:
Configuration:
Media: (STS_LSUF_REP_ENABLED | STS_LSUF_REP_SOURCE |
STLUF_RSUF_REP_TARGET | STS_LSUF_MIRROR_FLEXIBLE)
Save As: (STS_SA_SNAPSHOT | STS_SA_MIRROR)
Replication Sources: 3 (Network_NTAP:plinko:PrimarySnapshot
Network_NTAP:plinko:Netapp3140a2_SnapVault
Network_NTAP:plinko:Netapp3140a2_SecondSnapMirror)
Replication Targets: 2 (Network_NTAP:plinko:Netapp3140a2_SnapVault
Network_NTAP:plinko:Netapp3140a2_SecondSnapMirror)

...
Configuring disk pools for snapshot and replication

Using bpstsinfo to view the replication topology of the device
Configuring storage units and storage unit groups for snapshots and snapshot replication

This chapter includes the following topics:

- Creating storage units for snapshots and snapshot replication
- Creating a storage unit
- Creating storage unit groups for snapshots

Creating storage units for snapshots and snapshot replication

A storage unit is a label that NetBackup associates with physical storage. For snapshots and snapshot replication, a storage unit is configured to contain one snapshot disk pool.

Storage unit creation is part of several other wizards. However, a storage unit can be created directly from the Storage utility in the NetBackup Administration Console.

To create a storage unit for snapshots or snapshot replication

1. In the NetBackup Administration Console, select the Storage utility.
2. Select Actions > New > New Storage Unit.
3 Enter a **Storage unit name**.

See “NetBackup naming conventions” on page 28.

4 Select the **Storage unit type**. For snapshots and snapshot replication, select **Disk**.

5 Select a **Disk type**.

The **Disk type** identifies the type of storage unit. To configure snapshots and snapshot replication, select **OpenStorage (Vendor name)**.

For example, select **OpenStorage (Network_NTAP)** for a NetApp device.

6 A storage unit can contain either snapshot images or non-snapshot backup images, but it cannot contain both. In the **Storage unit configured for** drop-down list, indicate what the storage unit is to contain:

- **Backup** storage unit
  
  Upon selection, only those disk pools that can contain non-snapshot backups are displayed in the dialog box.

- **Snapshot** storage unit
  
  To configure snapshots and snapshot replication, select **Snapshot**.
  
  Upon selection, only those disk pools that can contain snapshots are displayed in the dialog box. Once a storage unit contains snapshots, it cannot contain non-snapshot backups.

7 Specify the properties that are required for the storage unit. Selecting a property filters the disk pools and displays only those that have the property selected.

For example, select **Replication source** and **Replication target** to display the disk pools that are configured to be both replication sources and targets for other replications. If no properties are selected, all disk pools appear.

(If you already know the name of the disk pool that has the properties that you want, select the disk pool from the **Select disk pool** drop-down menu. In that case, no filtering is necessary.)

8 In the **Select disk pool** drop-down list, select the disk pool that this storage unit is to contain. A storage unit can contain only one disk pool.

Click **View Properties** to display the properties of the selected disk pool.
Select the media server(s) that can use the storage unit.

**Use any available media server to transport data**
NetBackup selects any media server to access the storage unit.

**Use only the following media servers**
NetBackup uses only the media server(s) that are specified to access the storage unit.

Only the media servers that have the OpenStorage plug-in installed appear in this list. For a media server to communicate with and have access to a storage server, it must be added to the Replication Director environment.

See “Adding the storage server credentials to a NetBackup server” on page 44.

---

**Note:** A storage unit can represent many physical devices. When a storage unit is a replication target, NetBackup lets the plug-in select which device to use within the storage unit. For replication jobs, storage units and storage unit groups ignore the Maximum concurrent jobs setting. NetBackup does not attempt to throttle the parameters.

---

Click OK to save the storage unit configuration.

---

**Creating a storage unit**

A storage unit is a label that NetBackup associates with physical storage. The label can identify a robot, a path to a volume, or a disk pool. Storage unit creation is part of several other wizards. However, a storage unit can be created directly from the Storage utility in the NetBackup Administration Console.

For more information about the storage unit settings, see the online Help or the NetBackup Administrator’s Guide, Volume I.

**To create a storage unit**

1. In the NetBackup Administration Console, select the Storage utility.
2. Select Actions > New > New Storage Unit.
3. Enter a Storage unit name.
   See “NetBackup naming conventions” on page 28.
4. Select the Storage unit type. The selection specifies the type of storage that the storage unit uses: Media Manager, Disk, or NDMP.
5. For disk storage units:
Select a disk type from the **Disk type** drop-down menu. The **Disk type** identifies the type of storage unit destination:

- **AdvancedDisk storage units**
  The destination is a disk pool.

- **BasicDisk storage units**
  The destination is a path to a volume on a host.

- **NDMP storage**
  The destination is an NDMP host. The NDMP protocol is used to perform backups and recoveries.

- **OpenStorage storage units**
  The destination is a disk pool.
  To configure snapshots and snapshot replication with Replication Director, select **OpenStorage (storage type)**.
  For example, select **OpenStorage(Network_NTAP)** for a NetApp device.

- **PureDisk storage unit**
  The destination is a disk pool.

- **SharedDisk storage units**
  The destination is a disk pool.

- **SnapVault storage**
  The destination is a SnapVault server.

Select a media server in the **Media server** drop-down menu. The selection indicates that the media server has permission to write to the storage unit.

**Absolute pathname to directory** or **Absolute pathname to volume setting**.
Specifies the absolute path to a file system or a volume available for backups to disk.

**Maximum concurrent jobs**
Specifies the maximum number of jobs that NetBackup can send to a disk storage unit at one time.

**Reduce fragment size**
Adjust the fragment size to specify the largest fragment size that NetBackup can create to store backups.

**High water mark**
This setting applies to BasicDisk and disk pools. This value is a threshold that, when reached, causes NetBackup to consider the disk full and begin actions to reduce the data on the volume.
- **Low water mark**
  This setting has no effect unless backups are written through a storage lifecycle policy, using the capacity-managed retention type.

- **Enable block sharing**
  Allows the sharing of data blocks that have not changed from one backup to the next.

- **Enable Temporary staging area**
  Allows this storage unit to be used as a temporary staging area for basic disk staging.

6. For Media Manager storage units, data is written to tape robots and stand-alone tape drives:

- Select a storage device from the **Storage Device** drop-down menu.

- Select a media server in the **Media server** drop-down menu. The selection indicates that the media server has permission to write to the storage unit.

- **Maximum concurrent write drives**
  Specifies the number of tape drives that NetBackup can use at one time for jobs to this storage unit.

- **Enable multiplexing**
  Allows multiple backups to multiplex onto a single drive in a storage unit.

- **Reduce fragment size**
  Adjust the fragment size to specify the largest fragment size that NetBackup can create to store backups.

7. Click **OK** to save the storage unit configuration.

### Creating storage unit groups for snapshots

Creating storage unit groups is optional.

A snapshot storage unit group must be comprised of a homogenous set of storage units. That is, the storage units that are added into a new or an existing group must have matching properties.

The following procedure describes how to create a storage unit group that consists of storage units that can contain snapshots.
To create a snapshot storage unit group

1. In the NetBackup Administration Console, expand NetBackup Management > Storage.

2. Right-click Storage Unit Groups and select New Storage Unit Group.

3. Enter a storage unit group name for the new storage unit group. The storage unit group name is case-sensitive. See “NetBackup naming conventions” on page 28.

4. For the storage unit group to contain snapshots, select Snapshot in the drop-down menu.

5. A storage unit group can contain only those storage unit that share similar properties. NetBackup filters the storage units for selection so that dissimilar storage units are not combined in one storage unit group.

   **Note:** The properties of the underlying storage units are read-only. You cannot change the storage unit properties from this dialog box.

Select one or more properties to filter the storage units in the list. Only those storage units that have the selected properties are displayed. For example, select Replication source and Replication target to display only those storage units that are configured to act as both replication sources and replication targets.

Filter the storage units on the following properties:

- **Primary**
  - Enable Primary to display storage units that can contain the initial snapshot of primary data.

- **Replication source**
  - Enable Replication source to display storage units that can serve as a source for a replicated snapshot.

- **Replication target**
  - Enable Replication target to display storage units that can receive replicated snapshots from a replication source.

- **Mirror**
  - Optionally, enable Mirror to display storage units that can serve as a mirrored replication target. (For example, NetApp SnapMirror.)

- **Independent**
Optionally, enable **Independent** to display storage units that can act as either a **Mirror** replication target (SnapMirror) or a non-mirror replication target (SnapVault).

6 Add or remove storage units from the group:

- To add storage units to the group, select the storage units from the **Available storage units** list and click **Add**.
- To remove storage units from the group, select the storage units from the **Storage units to be used in the group** list and click **Remove**.

7 Click **OK** to save and close the dialog box.

Figure 6-1 Snapshot storage unit group configuration dialog box
Configuring storage units and storage unit groups for snapshots and snapshot replication

Creating storage unit groups for snapshots
About configuring storage lifecycle policies for snapshots and snapshot replication

A storage lifecycle policy (SLP) contains instructions in the form of storage operations, to be applied to the data. Operations are added to the SLP that determine how the data is stored and copied or replicated. For example, the NetBackup administrator creates an operation that determines where the data exists as a snapshot, as a replication, or as a duplication. The administrator also determines the retention of the data at each storage unit or storage unit group.

After the SLP is configured for different operations, the NetBackup administrator configures a backup policy that points to the snapshot SLP.
Storage operations that are defined in the SLP use storage units that represent disk pools.

An SLP that is configured for snapshots or snapshot replication must contain a specific, hierarchical combination of operations.

The following figure represents an SLP for a replication scenario. In the example, the following operations are used:

- A **Snapshot** operation creates a snapshot.
- A **Replication** operation replicates the snapshot to another volume.
- A **Backup From Snapshot** operation creates a tar-formatted backup from the snapshot.
- A **Duplication** operation copies the backup to tape.

**Table 7-1** describes the four types of operations that are required in this example replication scenario.

### Table 7-1 Example of a storage lifecycle policy configured for snapshots and snapshot replication

<table>
<thead>
<tr>
<th>Operation order in SLP</th>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1                      | **Snapshot**  | Operation 1 creates a snapshot in the primary storage. The snapshot serves as the source for the other operations in the SLP.  
- The operation must be a **Snapshot** operation.  
- The storage must be a snapshot storage unit that has the following properties set: **Primary** and **Replication source**.  
**Note:** Only one operation to a **Primary** storage unit is permitted in an SLP. |
Table 7-1  Example of a storage lifecycle policy configured for snapshots and snapshot replication (continued)

<table>
<thead>
<tr>
<th>Operation order in SLP</th>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2                      | Replication              | Operation 2 replicates the snapshot created by the first operation.  
| (Child to operation 1) |                          | ■ The operation must be a *Replication* operation and it must be the replication partner to the source storage unit.  
|                        |                          | ■ The storage must be a snapshot storage unit that has the *Replication target* property set. Since no other replica is created from this operation in this example, it does not need to have the *Replication source* property set. |
| 3                      | Backup From Snapshot     | Operation 3 creates a tar-formatted backup copy of the snapshot.  
| (Child to operation 2) |                          | ■ The operation must be a *Backup From Snapshot* operation. This operation creates a backup image from the snapshot.  
|                        |                          | ■ The storage must be a backup storage unit. |
| 4                      | Duplication              | Operation 4 makes a duplicate copy from the tar backup copy. In this example, the copy is duplicated to tape media.  
| (Child to operation 3) |                          | ■ The operation must be a *Duplication* operation. This operation creates a backup copy of the tar-formatted image.  
|                        |                          | ■ The storage must be a backup storage unit. |

Creating a storage lifecycle policy for snapshots and snapshot replication

Use the following procedure to create a storage lifecycle policy that creates snapshots and snapshot replications with Replication Director:

To create a storage lifecycle policy to create snapshots and snapshot replication

1. In the *NetBackup Administration Console*, expand *NetBackup Management*, and then expand *Storage*. Select *Storage Lifecycle Policies*.
2. Click *Actions* > *New* > *New Storage Lifecycle Policy*.
3. In the *New Storage Lifecycle Policy* dialog box, enter a *Storage lifecycle policy name*.  
   See “*NetBackup naming conventions*” on page 28.
4. Select a *Data classification*. (Optional.)
5 Select the **Duplication job priority**. (Optional.)

This number represents the priority that duplication jobs have in relationship to all other jobs. In duplication jobs, NetBackup duplicates data from a backup storage unit to a duplication storage unit.

6 Click **Add** to add operations to the SLP. The operations are the instructions for the SLP to follow and apply to the data that is eventually specified in the backup policy.

   ![New Storage Lifecycle Policy dialog box](image)

The **New Storage Operation** dialog box appears. In the **Operation** drop-down menu, select **Snapshot**.

This **Snapshot** operation creates a snapshot of the primary data and serves as the source for other operations in the SLP. For example:

- A **Replication** operation.
  
  See “**Replication operation**” on page 91.

- A **Backup From Snapshot** operation.
  
  See “**Backup From Snapshot operation**” on page 95.

- An **Index From Snapshot** operation.
  
  See “**Index From Snapshot operation**” on page 92.
7 In the **Storage unit** drop-down menu, select the storage unit that is configured to contain primary snapshots.

**Note:** In NetBackup 7.5, the **Any_Available** selection is not available for new SLPs. In an upgrade situation, existing SLPs that use **Any_Available** continue to work as they did before NetBackup 7.5. However, if the NetBackup administrator edits an existing SLP, a specific storage unit or storage unit group must be selected before the SLP can be saved successfully.

8 Select the **Retention type** and the **Retention period** for the data in this storage unit. The **Retention period** option does not appear for all **Retention type** selections. Click **OK**.
To replicate the primary snapshot, create a replication operation that is based on the snapshot operation. Click on the first operation and then select **Add**. The **New Storage Operation** dialog box appears.

10 In the **Operation** drop-down menu, select **Replication**. This **Replication** operation creates a replication of the primary snapshot.

11 Under **Local storage**, select the **Storage unit** that is configured to contain replicated snapshots. The **Target master** option is used for Auto Image Replication and is not selectable in a Replication Director configuration.
12 Select the **Retention type** and the **Retention period** for the data in this storage unit.

Optionally, indicate an **Alternate read server** that is allowed to read a snapshot that was originally written by a different media server. Click **OK**.

13 Click **OK** to create the storage operation.

Continue to create operations, depending on the needs of your environment.

To cascade storage operations in the SLP, make sure to select the correct parent operation as the source for the child operation. If the correct operation is not selected, you unintentionally perform an operation on an incorrect source.

**Operation types in a storage lifecycle policy**

In the **New** or **Change Storage Operation** dialog box, select the next operation that the SLP is to perform.

The **New** or **Change Storage Operation** dialog box is initiated by clicking the **Add** button in the **New** or **Change Storage Lifecycle Policy** dialog box.

Different operations appear in the dialog box, depending on the **Operation** selection.

The **Operation** selections are the instructions for the storage lifecycle policy. A storage operation can be configured for the following purposes:

- See “**Snapshot operation**” on page 86.
- See “**Replication operation**” on page 91.
- See “**Index From Snapshot operation**” on page 92.
- **Backup** operation. When a **Backup** operation appears in an SLP, it must be the first operation. In an SLP that is configured for Replication Director, the first operation must be a **Snapshot** operation. Since this guide concentrates on Replication Director, the **Backup** operation is not described here.
- See “**Backup From Snapshot operation**” on page 95.
- See “**Duplication operation**” on page 97.
- **Import** operation. An **Import** operation is used in Auto ImageReplication, in which an SLP is used to import a backup into a target NetBackup domain. Since this guide concentrates on snapshots, the **Import** operation is not described here.

All operations are described in the *NetBackup Administrator's Guide, Volume I* or the online Help in the **NetBackup Administration Console**.
Snapshot operation

A **Snapshot** operation creates a point-in-time, read-only, disk-based copy of a client volume. NetBackup provides several types of snapshots, depending on the device where the snapshot occurs.

Use a **Snapshot** operation as the first operation in a storage lifecycle policy for a NetBackup Replication Director configuration.

**Figure 7-1** Snapshot operation in the New Storage Operation dialog box
### Table 7-2  Snapshot operation characteristics

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit selection</td>
<td>The following topics describe types of snapshot storage units that can be used as the storage for a snapshot operation:</td>
</tr>
<tr>
<td></td>
<td>■ See “Primary snapshot storage unit” on page 88.</td>
</tr>
<tr>
<td></td>
<td>■ See “Primary + Replication source snapshot storage unit” on page 89.</td>
</tr>
<tr>
<td></td>
<td>■ See “Replication source + Replication target snapshot storage unit” on page 90.</td>
</tr>
<tr>
<td></td>
<td>■ See “Replication target snapshot storage unit” on page 90.</td>
</tr>
<tr>
<td></td>
<td>■ See “Replication source + Replication target + Mirror snapshot storage unit” on page 91.</td>
</tr>
<tr>
<td></td>
<td>■ See “Replication source + Replication target + Mirror snapshot storage unit” on page 91.</td>
</tr>
<tr>
<td></td>
<td>A Storage unit selection is necessary in the following situations:</td>
</tr>
<tr>
<td></td>
<td>■ If the Snapshot is to be used by a subsequent Replication operation.  The storage unit that is specified for the Snapshot operation must be a snapshot-capable storage unit that represents the primary storage.</td>
</tr>
<tr>
<td></td>
<td>■ If the SLP contains only one operation and that is a Snapshot operation, specify a storage unit. NetBackup uses that storage unit to determine which media server to use to launch the snapshot job.</td>
</tr>
<tr>
<td></td>
<td>If neither situation applies to the SLP, the administrator may select No storage unit or may simply make no selection. NetBackup uses the storage unit that is selected for the Backup From Snapshot operation.</td>
</tr>
<tr>
<td>Child of</td>
<td>A Snapshot operation cannot be the child of another operation.</td>
</tr>
<tr>
<td>Source for</td>
<td>A Snapshot operation can be the source for the following operations:</td>
</tr>
<tr>
<td></td>
<td>■ Backup From Snapshot</td>
</tr>
<tr>
<td></td>
<td>■ Index From Snapshot</td>
</tr>
<tr>
<td></td>
<td>■ Replication operation</td>
</tr>
<tr>
<td>Hierarchy notes</td>
<td>If a Snapshot operation appears in an SLP, it must be first in the operations list.</td>
</tr>
<tr>
<td></td>
<td>An SLP can contain a maximum of four Snapshot operations.</td>
</tr>
<tr>
<td>Job type</td>
<td>A Snapshot operation generates a Snapshot job in the Activity Monitor.</td>
</tr>
</tbody>
</table>

See “About configuring storage lifecycle policies for snapshots and snapshot replication” on page 79.

See “Upgrades and policies that use Instant Recovery” on page 161.
Primary snapshot storage unit

A snapshot operation can use a **Primary** snapshot storage unit. That is, the storage unit represents a disk pool that contains the volumes that have only the **Primary** property set.

Figure 7-2 shows an SLP that contains one primary-only **Snapshot** operation, one **Backup From Snapshot** operation, and one **Duplication** operation. The **Backup From Snapshot** operation is used to create a backup from the snapshot on the primary-only **Snapshot** operation. After the backup is created, it is duplicated to a **Duplication** operation.

Figure 7-2  SLP that contains a Snapshot operation, a Backup From Snapshot operation, and a Duplication operation

---

**Figure 7-3** shows a storage lifecycle policy that contains one primary-only **Snapshot** operation.

The SLP in **Figure 7-3** cannot perform replication for the following reasons:

- The primary-only operation does not have the source property set so that it can act as a source for replication.
- The SLP does not contain a **Replication target** for a replica.
An SLP operation can use a **Primary + Replication source** snapshot storage unit. That is, the storage unit represents a disk pool that contains volumes that have both the **Primary** property and the **Replication source** property set.

**Figure 7-4** shows an SLP that contains a **Primary + Replication source** snapshot storage unit as one operation and one **Replication target** snapshot storage unit as another operation. The **Primary + Replication source** storage unit can replicate to the **Replication target** storage unit.

Similar to an SLP that contains only one **Primary** snapshot storage unit operation, an SLP that contains only one **Primary + Replication source** storage unit operation cannot perform replication because the SLP does not contain a **Replication target**.
Replication source + Replication target snapshot storage unit

An SLP operation can use a snapshot storage unit that represents a disk pool that contains volumes that have the following properties: Replication source and Replication target.

A snapshot storage unit with these properties can serve as both the Replication source for another operation in the SLP, and as the Replication target for another operation in the SLP.

Figure 7-5  SLP that contains a Snapshot operation and two Replication operations

Replication target snapshot storage unit

An SLP operation can use a snapshot storage unit that represents a disk pool that contains volumes that have only the Replication target property set.

An operation with this property can serve only as a Replication target for another operation in the SLP. It cannot serve as source for a replica, but it can serve as the source for a Duplication operation.
Replication source + Replication target + Mirror snapshot storage unit

An SLP can use a snapshot storage unit that represents a disk pool that contains volumes that have the following properties: **Replication source**, **Replication target**, and **Mirror**.

An operation with these properties can serve as both:

- A **Replication source** in a cascading configuration.
- A mirrored **Replication target** in a cascading configuration. A mirrored **Replication target** must have a forced **Mirror** retention type.

Replication target + Mirror snapshot storage unit

An SLP can use a snapshot storage unit that represented a disk pool that contains volumes that have the following properties: **Replication target** and **Mirror**.

A mirrored **Replication target** must have a forced **Mirror** retention type.

Replication operation

Use the **Replication** operation to create a copy of a snapshot. Use a **Replication** operation in a storage lifecycle policy for a NetBackup Replication Director configuration.
Table 7-3 Replication operation characteristics

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| Storage unit selection | Under Local storage, select the Storage unit that is configured to contain replicated snapshots. The Target master option is used for Auto Image Replication and is not selectable in a Replication Director configuration.  
A Replication operation must have the same type of storage unit as its source operation.  
For snapshot replication with Replication Director, the source operation must be a snapshot storage unit or a snapshot storage unit group. |
| Child of            | A Replication operation can be the child of a Snapshot operation or another Replication operation.                                                                                                           |
| Source for          | A Replication operation can be the source for the following operations:  
  - Replication  
  - Backup From Snapshot  
    See “Backup From Snapshot operation” on page 95.                                                                                      |
| Job type            | A Replication operation generates a Replication job in the Activity Monitor.                                                                                                                                |

See “About Replication Director” on page 15.

Index From Snapshot operation

Use the Index From Snapshot operation to index (that is, to catalog) snapshots. Indexing a snapshot creates an image .f file for the snapshot in the NetBackup catalog. With the image .f file in place, the administrator can browse and restore...
files and directories from any copy of that snapshot, even those in long-term storage.

The administrator can restore the files by using the NetBackup **Backup, Archive, and Restore** client interface or the **Restore** operation in OpsCenter. Use the **bplist** command to view the contents of the .f file.

Without the **Index From Snapshot** operation, it is not possible to browse and restore individual files and folders.

A storage unit selection is not required for this operation because nothing is written to storage. A storage unit selection simply associates a media server with this operation.

**Figure 7-8** Index From Snapshot operation in the New Storage Operation dialog box

For more information on OpsCenter Operational Restore, see the *Symantec OpsCenter Administrator's Guide.*

Keep in mind the following items before using the **Index From Snapshot** operation:

- The **Index From Snapshot** operation is supported only in a Replication Director configuration.

- **Standard** and **MS-Windows** backup policy types support the use of storage lifecycle policies that contain the **Index From Snapshot** operation.
  
  The **Index From Snapshot** operation is not supported for any policy that uses NDMP. (For example, an NDMP policy, or a **Standard** or **MS-Windows** policy with NDMP **Data Mover** enabled.)
Table 7-4  Index From Snapshot operation characteristics

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit selection</td>
<td>Select the same storage unit that is selected for the Snapshot operation.</td>
</tr>
<tr>
<td>Child of</td>
<td>When an Index From Snapshot operation appears in an SLP, it must be the child of a Snapshot or Replication operation.</td>
</tr>
<tr>
<td>Source for</td>
<td>While an Index From Snapshot operation cannot be the source for any operation, a Replication operation can follow it.</td>
</tr>
<tr>
<td>Hierarchy notes</td>
<td>See “Positioning the Index From Snapshot operation in the operations list of an SLP” on page 94.</td>
</tr>
<tr>
<td>Job type</td>
<td>An Index From Snapshot operation generates a Index From Snapshot job in the Activity Monitor.</td>
</tr>
</tbody>
</table>

Positioning the Index From Snapshot operation in the operations list of an SLP

The Index From Snapshot operation differs from other operations in that it does not create a copy of a snapshot or backup.

Keep in mind that even though the Index From Snapshot operation does not create a copy, the existence of the operation in the SLP counts toward the number indicated by the Maximum backup copies. The Maximum backup copies property in the Global Attributes host properties specifies the total number of backup copies that can exist in the NetBackup catalog.

Use the following points to determine where to position the Index From Snapshot operation in the operations list of an SLP:

- Use the Index From Snapshot operation in an SLP only once. A restore can be performed from any snapshot after one image .f file is created.

- An Index From Snapshot operation cannot have any dependents. An SLP cannot validate an Index From Snapshot operation with children. Figure 7-9 shows an SLP with a valid configuration. Figure 7-10 is also a valid configuration. A Replication operation follows the Index From Snapshot operation, but it is not indented. The Replication operation is a child of the Snapshot operation, not a child of the Index From Snapshot operation.

To add a Replication operation after an Index From Snapshot operation, click on the Snapshot operation, and then click Add.

- Additional system resources are required for NetBackup to create an image .f file.
Each NetBackup environment needs to determine where the operation works best in a specific SLP. To place the **Index From Snapshot** operation too early (toward the top of the operations list), may consume time when the restore capabilities are not needed. To place the operation too late (toward the end of the operations list) may cause the administrator to delay a restore until earlier snapshots or replications complete.

- Any operations list that includes a **Backup** operation does not need an **Index From Snapshot** operation. The **Backup** operation creates an image `.f` file. The only exception is if the index is needed for restores before the **Backup** operation occurs.

**Figure 7-9** Example 1 of a valid placement of the Index From Snapshot operation

**Figure 7-10** Example 2 of a valid placement of the Index From Snapshot operation

**Backup From Snapshot operation**

Use the **Backup From Snapshot** operation to create a tar-formatted copy of the snapshot. The new copy is a backup copy. The process is sometimes referred to as a snapdupe job.
Figure 7-11  Backup From Snapshot operation in the New Storage Operation dialog box

![Backup From Snapshot operation in the New Storage Operation dialog box](image)

Table 7-5  Backup From Snapshot operation characteristics

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit selection</td>
<td>The selection must be a backup storage unit or a backup storage unit group. The selection cannot be a snapshot storage unit or a snapshot storage unit group.</td>
</tr>
<tr>
<td>Child of</td>
<td>A Backup From Snapshot operation must use a Snapshot operation as its source.</td>
</tr>
<tr>
<td>Source for</td>
<td>A Backup From Snapshot operation can be the source for a Duplication operation. (See Figure 7-12.)</td>
</tr>
<tr>
<td>Hierarchy notes</td>
<td>An SLP may contain more than one Backup From Snapshot operation. If the first Backup From Snapshot operation fails with an unrecoverable error, NetBackup does not attempt the second one.</td>
</tr>
<tr>
<td>Job type</td>
<td>A Backup From Snapshot operation generates a Backup job in the Activity Monitor. The Backup job that results from the Backup From Snapshot operation is under the control of the SLP and the Duplication Manager. The Duplication Manager decides when to run the backup job, which may be outside of the backup window as defined in the backup policy. Users may experience a slight degradation in performance on the client or the client storage device while NetBackup accesses the snapshot.</td>
</tr>
</tbody>
</table>
**Figure 7-12** SLP that contains a Backup From Snapshot operation

Use the **Duplication** operation to create a copy of a **Backup** operation. A media server performs the operation and writes the copy.

Use the **Replication** operation to create a copy of a **Snapshot** operation.

**Figure 7-13** Duplication operation in the New Storage Operation dialog box

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| Storage unit selection | The selection must be a backup storage unit or a backup storage unit group.  
The selection cannot be a snapshot storage unit or a snapshot storage unit group. |
### Table 7-6 Duplications operation characteristics (continued)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| Child of         | A Duplications operation can be the child of the following operations:  
|                  | - Backup operation                                                                                                                          |
|                  | - Backup From Snapshot operation                                                                                                           |
|                  | - A Duplications operation                                                                                                                  |
| Source for       | A Duplications operation can be the source for a Duplications operation. (See Figure 7-14.)                                                   |
| Hierarchy notes  | When a Duplications operation appears in an SLP, it cannot be the first operation.                                                           |
| Job type         | A Duplications operation generates a Duplications job in the Activity Monitor.                                                                 |

**Figure 7-14**  
SLP that contains one Backup operation and two Duplications operations

---

### Retention types for storage lifecycle policy operations

The **Retention type** for an operation in a storage lifecycle policy determines how long the data is kept on that storage media.

*Table 7-7* describes which retention types are valid selections for the various operations.
Table 7-7 Operation and retention type configurations

<table>
<thead>
<tr>
<th>Retention type</th>
<th>Backup operation</th>
<th>Snapshot operation</th>
<th>Replication operation</th>
<th>Backup From Snapshot operation</th>
<th>Duplication operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed</td>
<td>Valid</td>
<td>Valid</td>
<td>Valid</td>
<td>Valid</td>
<td>Valid</td>
</tr>
<tr>
<td>Expire after copy</td>
<td>Valid</td>
<td>Valid</td>
<td>Invalid</td>
<td>Valid</td>
<td>Valid</td>
</tr>
<tr>
<td>Maximum Snapshot limit</td>
<td>Invalid</td>
<td>Valid; SLP honors the policy setting.</td>
<td>Invalid</td>
<td>Invalid</td>
<td>Invalid</td>
</tr>
<tr>
<td>Mirror</td>
<td>Invalid</td>
<td>Invalid</td>
<td>Valid for snapshot storage only</td>
<td>Invalid</td>
<td>Valid for snapshot storage only</td>
</tr>
<tr>
<td>Target retention</td>
<td>Invalid</td>
<td>Invalid</td>
<td>Valid if the first operation in the SLP is an Import and if the storage is of the backup type.</td>
<td>Invalid</td>
<td>Valid if the first operation in the SLP is an Import.</td>
</tr>
<tr>
<td>Capacity managed</td>
<td>Valid; AdvancedDisk default; set on the storage server.</td>
<td>Invalid</td>
<td>Invalid</td>
<td>Invalid</td>
<td>Valid; AdvancedDisk default; set on the storage server.</td>
</tr>
</tbody>
</table>

Note: No retention is associated with the IndexFromSnapshot operation because the operation does not create any copy.

Capacity managed retention type for SLP operations

A Capacity managed operation means that NetBackup automatically manages the space on the storage, based on the High water mark setting for each volume. Capacity managed is not available to tape storage units since tape capacity is considered to be infinite.

The High water mark and Low water mark settings on the disk storage unit or disk pool determine how the space is managed.

An image copy with a Capacity Managed retention is not eligible for expiration until its dependent copies have been created.
If space is needed for new images, NetBackup removes expired backup images from a capacity managed disk volume in two passes, as follows:

**Pass one**
NetBackup removes any backup images that are past the Desired cache period setting. NetBackup removes images until the low water mark is reached or all images that are past the Desired cache period are removed.

**Pass two**
Pass two processing is initiated if the outcome of the pass one processing is one of the following:
- The disk pool remains over the high water mark.
- The number of volumes in the disk pool under the high water mark is less than the number of media servers that access the disk pool.

NetBackup removes images until the low water mark is reached or all images that are not past the Desired cache period are removed.

An image may be deleted if it has not been duplicated for all operations in a storage lifecycle policy. If the operating system time is past the date that matches the longest retention period for an image, the image is eligible for deletion.

To see exactly when the storage reaches the low water mark value is difficult. A backup can occur at the same time as the expiration process occurs. After the backup is complete, the low water mark may be slightly greater than its lowest possible value.

The retention period for capacity managed storage is not assured as it is for a fixed retention period. The Desired cache period becomes a target that NetBackup tries to maintain. If the space is not required, the backup data could remain on the storage longer than the Desired cache period indicates.

**Capacity managed** is selectable for any disk storage unit that is allowed in a storage lifecycle policy. However, for the disk types that support single-instance storage (SIS), **Capacity managed** functions to various degrees. In order for **Capacity managed** to operate, NetBackup must know how much space a backup image uses. With SIS enabled on the storage unit, NetBackup cannot know exactly how much space a particular backup image occupies.

The following storage unit configurations use SIS:
- PureDisk storage units
- Some OpenStorage storage units, depending on the characteristics of the OpenStorage partner.
Rules and recommendations for using the Capacity Managed retention type

Use the following recommendations and rules when configuring storage operations or when selecting the storage location for a policy:

- Symantec does not recommend allowing Capacity Managed images and Fixed retention images to be written to the same volume in a disk storage unit. The volume may fill with fixed-retention images and not allow the space management logic to operate as expected.

- All SLPs that write to a volume in a disk storage unit should write images of the same retention type: Fixed or Capacity Managed.

- Do not write images both to a volume in a disk storage unit within a storage lifecycle policy and to the same volume (by the storage unit) directly from a policy.

- Mark all disk storage units that are used with SLPs as On demand only.

- Check any storage unit groups to make sure that fixed and capacity-managed images cannot be written to the same volume in a disk storage unit.

Expire after copy retention type for SLP operations

The Expire after copy retention indicates that after all direct child copies are successfully duplicated to other storage, the data on this storage is expired. The last operation in the SLP cannot use the Expire after copy retention type because no subsequent copy is configured. Therefore, an operation with this retention type must have a child.

If a policy is configured to back up to an SLP, the retention that is indicated in the SLP is the value that is used. The Retention attribute in the schedule is not used.

An image copy with an Expire after copy retention is expired as soon as all of its direct child copies have been successfully created. Any mirrored children must also be eligible for expiration.

Fixed retention type for SLP operations

The Fixed retention indicates that the data on the storage is retained for the specified length of time, after which the backups are expired.

An image copy with a Fixed retention is eligible for expiration when all of the following criteria are met:

- The Fixed retention period for the copy has expired.

- All child copies have been created.
All child copies that are mirror copies are eligible for expiration. The Fixed retention period is always marked from the original backup time of the image. For example, if a tape device is down, causing a 2-day delay in creating a duplicate tape copy, the expiration time of the duplicate copy is not different due to the 2-day delay. The expiration time of the duplicate copy is still $x$ days from the time that the original backup was completed. It does not matter when the copy was created.

**Maximum snapshot limit retention type for SLP operations**

Only snapshot operations use the Maximum snapshot limit retention type. This retention indicates that the snapshot copy has no defined expiration time and is to be deleted based on the maximum snapshot limit that is defined in the policy. The maximum number of snapshots is defined in the Snapshot Client properties section of the policy.

**Mirror retention type for SLP operations**

A mirror replica is eligible for expiration as soon as:

- All immediate child copies are successfully created.
- All immediate child copies that are mirrors are eligible for expiration.

The Mirror retention cannot be selected by the NetBackup administrator directly. The Mirror retention is automatically selected if the storage device is a mirror, configured by the storage administrator.

In mirror replication, the replica copy is dependent on the existence of the source. (The source could be the original snapshot or another replica.) Therefore, the retention of the replica depends on the retention of the source. If the source is deleted, the mirror is automatically deleted. If the mirror is deleted first, it is automatically recreated to maintain its mirror status.

In non-mirror replication, the replica is independent of the source and can have an independent retention. If the source is deleted, the non-mirror replica is not impacted and can be used longer than the source. Or, if the replica is deleted first, it is not recreated and the source can be kept longer than the replica.

**Target retention type for SLP operations**

This setting is used in Auto Image Replication in an Import storage lifecycle policy. Every Import SLP must have at least one operation with a Target retention.

The Target retention is enforced at the target domain, but the actual retention for the data is specified by the administrator at the source domain.
**Target retention** indicates that the data at the target master shall use the expiration date that was imported with the image. The date is fixed because the copy must have a fixed retention.

Similar to the **Fixed** retention, an image copy with a Target retention retention is eligible for expiration when all of the following criteria are met:

- The **Fixed** retention period for the copy has expired.
- All child copies have been created.
- All child copies that are mirror copies are eligible for expiration.
Configuring storage lifecycle policies for snapshots and snapshot replication

Retention types for storage lifecycle policy operations
Configuring backup policies to create snapshots and snapshot replication

This chapter includes the following topics:

- Configuring a policy for use with Replication Director
- About NDMP support for Replication Director

Configuring a policy for use with Replication Director

To create snapshots, NetBackup must run a backup policy that is configured to create snapshots.

To create a policy for use with Replication Director

1. In the NetBackup Administration Console, in the left pane, expand NetBackup Management > Policies.
2. On the Actions menu, click New > New Policy.
3. Type a unique name for the new policy in the Add a New Policy dialog box. See “NetBackup naming conventions” on page 28.

Note: Do not use the Policy Configuration Wizard or the Getting Started Wizard to configure a policy for Replication Director.

5. Click OK.
Configuring backup policies to create snapshots and snapshot replication

Configuring a policy for use with Replication Director

6 Configure the options on the policy Attributes tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Policy type</strong></td>
<td>For NetBackup to perform non-NDMP backups, select <strong>Standard</strong> or <strong>MS-Windows</strong>.</td>
</tr>
<tr>
<td><strong>Data classification</strong></td>
<td>(Optional for Replication Director.) The data classification of the policy must match the data classification of the SLP selected for the backup.</td>
</tr>
<tr>
<td><strong>Policy storage</strong></td>
<td>To use Replication Director, the storage selection must be an SLP. Select the SLP that you want to use that has been configured for snapshots and snapshot replication.</td>
</tr>
<tr>
<td><strong>Perform snapshot backups</strong></td>
<td>Enable <strong>Perform snapshot backups</strong> so that the policy takes snapshots of the clients. This option must be enabled for Replication Director configuration.</td>
</tr>
</tbody>
</table>
Click **Options**. From the **Snapshot method** drop-down menu, select **OST_FIM**. The options that appear depend on the selected policy type.

**Note:** The **OST_FIM** method works only if the **Policy storage** attribute points to a storage lifecycle policy that contains a snapshot-capable storage unit.

The **OST_FIM** method provides two configuration parameters.
This parameter indicates which snapshot technology the OpenStorage partner should use to create the snapshot:

- **0-Auto**
  This parameter indicates to the partner to use the best snapshot technology available to that particular partner to create the snapshot. For example, when 0 is indicated, the OpenStorage partner NetApp selects **3-Diff**.

- **1-Clone**
  This parameter indicates to the partner to create an independent copy of the volume. The copy process can take some time as the entire copy must be complete.
  The snapshot that is created is independent of the source.

- **2-Plex**
  This parameter indicates to the partner to create a snapshot that is completely independent of the source snapshot. This parameter is based on mirror-break-off technology.
  When a mirror device is attached to the source, the contents of the mirror device is exactly the same as source device. When the relationship is broken between the two, the mirror device is separated from the source. The mirror device acts as a point-in-time copy.

- **3-Diff**
  This parameter indicates to the partner to create a snapshot that is completely dependent on the source. This parameter is based on copy-on-write technology.
  The device creates a cache object to maintain the original blocks of the snapshot when the blocks are modified.

For more information on each snapshot type, see the *NetBackup Snapshot Client Administrator's Guide*.

### Maximum Snapshots configuration parameter

This parameter sets the maximum number of Instant Recovery snapshots to be retained at one time. When the maximum is reached, the next snapshot causes the oldest to be deleted.

Click **OK** to save the configuration and close the **Snapshot Client Options** dialog box.

### Retain snapshots for Instant Recovery

**Note:** This option must be enabled for Replication Director configuration.

Enable this option for a snapshot-only backup, or to keep the snapshot after the backup completes.
Collect true image restore information with move detection

This option is not supported in SLPs that are configured for snapshots and snapshot replication.

For descriptions of all policy options, see the NetBackup Administrator’s Guide, Volume I or the online Help.

7 Select the Schedules tab and configure the schedules as you would for any other policy.

See the NetBackup Administrator’s Guide, Volume I or the online Help.

8 Select the Clients tab and specify the local mount point on the client (the mount host).

To create snapshots and snapshot replications with Replication Director, clients must have NetBackup 7.5 client software installed.

Make sure that the mount host can reach the storage system of the OpenStorage partner and the data volume to be backed up. For example, where the partner is NetApp, make sure that the mount host can reach the data volume on the NetApp storage system.

To test the connectivity, run the ping command from the mount host for the storage system. It must be reachable from the mount host using the DNS name.

ping storage_system_dnsname

Also, make sure that the data volume from the storage system is properly mounted on the mount host.

To test, run the mount command or use the df -k command on the mount host.

Note: If the same CIFS or NFS share that is to be backed up is accessed from multiple clients, do not add all of the clients to the policy. Instead, enter only one of the clients so that the share is backed up once. Or, create an NDMP policy to back up the share.

Adding multiple clients to the policy that access the same share causes NetBackup to create a snapshot of the same data multiple times.

9 Select the Backup Selections tab to indicate the client data to be backed up as part of the snapshot.
Windows path names must use the Universal Naming Convention (UNC), in the form `\server_name\share_name`.

All paths must be valid for a client.

The client data must reside on a NAS host. The data must be mounted on the client by means of NFS on UNIX or shared by means of CIFS on Windows. For NFS mounts, the data must be manually mounted by means of the `mount` command, not auto-mounted.

The mount point listed in the backup selection cannot contain any spaces or XML markup.

Use the `nosharecache` option to mount qtrees that are under the same volume. For example:
```bash
mount -o vers=3,nosharecache filer:/vol/volume1/qtree1 /mnt1
```

In the backup selections list for a **Standard** policy that uses the **OST_FIM** snapshot method, do not include non-NFS directories. Policy validation fails if non-NFS directories are included. If both NFS and non-NFS directories are included in the backup selections list, policy validation fails for the non-NFS backup selections.

Specify the mount point for the directories, volumes, or files from the client perspective.

**UNIX example:** The data resides in `/vol/vol1` on the NDMP host `nas1`. The data is NFS-mounted to `/mnt2/home` on the UNIX client. Specify `/mnt2/home` in the **Backup Selections** list.

**Windows example:** The data resides in `/vol/vol1` on the NDMP host `nas1`. The data is shared by means of CIFS as `vol1` on the Windows client. Specify `\nas1\vol1` in the **Backup Selections** list. This requires that the NetBackup Client Service on the Windows client be running as a non-system user. Do not ignore the warning that displays. By default, NetBackup is installed as Local System (the system account). Change the logon property of the NetBackup Client Service to an account with access to the CIFS share.

For example, to log in to the NetBackup Client Service as the Administrator account:

- **In Windows Services,** double-click the NetBackup Client Service.
- Select the **Log On** tab. If the service is not logged on as Administrator, stop the service.
- Change the logon to the Administrator account and restart the service.
About NDMP support for Replication Director

Replication Director enables NetBackup to use NDMP to perform the following operations:

- Restore from snapshot backups.
- Perform a live browse of snapshots.
- Restore from snapshots for the copy back method.
Support for all of the operations is provided for replicated snapshots as well. Consider the following items before configuring NDMP to be used with Replication Director:

- To use the Point in Time rollback restore method, select the **Skip verification and force rollback** operation.
- To restore from backups for a standard or Windows client, all destinations must be mounted and shared from a compatible filer. All destinations must be on the same filer.
- To restore from backups for a standard or Windows client, do not mix backup selections: selections created from a policy with NDMP Data Mover enabled and selections from a policy without NDMP Data Mover enabled.
- User restores can be directed to any volume that the user can NFS or CIFS mount. Denying NFS or CIFS write access does not prevent the restore because the filer performs an NDMP restore.

**Limitations of NDMP support for Replication Director**

Replication Director and NDMP does not support the following items:

- The Solaris_x86 operating system is not supported.
- The **Multiple copies** NetBackup policy option is not supported for image copies in the NDMP data format.
- The **Restore the file using a temporary filename** restore option is not supported on Windows clients.
- Restores to a local file system are not supported with a **MS-Windows** or **Standard** policy that has the NDMP Data Mover enabled.
- Do not create a **MS-Windows** or **Standard** policy that contains backup selections that are on different filers. However, backup selections on different filers are supported if multistreaming is configured so that each backup selection is backed up in a separate job.
- Volume snapshot replication of qtree and non-qtree data is not supported.
- Only one NDMP backup of a snapshot per backupid is allowed.

**Authorizing NetBackup access to the NDMP host**

Before NetBackup can perform backups, it must have access to the NDMP host.
Note: Perform the following procedure on the master server (not media server) if you plan to create snapshots using the Snapshot Client NAS_Snapshot method.

To authorize NetBackup access to the NDMP host

1. On the NetBackup server NetBackup Administration Console, expand Media and Device Management > Credentials > NDMP Hosts.
2. Under the Actions menu, select New > New NDMP Host.
3. In the Add NDMP Host dialog box, enter the name of the NDMP server for NetBackup to back up.
   The NDMP host name is case-sensitive. Whenever this host name is used, the name must be identical to the name entered here. (For example, when you configure tape drives and storage units for this host.)
4. Click OK.
5. In the New NDMP Host dialog box, specify the following:
   (The term credentials refer to the user name and password that NetBackup uses to access the NDMP host.)

- **Use global NDMP credentials for this NDMP host**
  Enables all NetBackup media servers under the master server to access this NDMP host using a predefined global NDMP logon.
  To create this logon, click Host Properties > Master Server > Properties > NDMP in the NDMP Global Credentials dialog box.

- **Use the following credentials for this NDMP host on all media servers**
  Enables all NetBackup media servers that are connected to the NDMP host to access the NDMP host using the logon you specify:
  - **User name**: The user name under which NetBackup accesses the NDMP server. This user must have permission to run NDMP commands. You can find out whether your NDMP host vendor requires a particular user name or access level.
  - **Password and Confirm Password**: Enter the password for this user.
Specifies NDMP logons for particular NetBackup servers. Then click Advanced Configuration.

- In the Advanced NDMP Credentials dialog box, click Add.
- In the Add Credentials dialog box, select a NetBackup server and specify the user name and password it uses to access the NDMP host.
- Click OK. NetBackup validates the user name and password.
- The NetBackup server and user name appear in the Advanced NDMP Credentials dialog box.
- If necessary, click Add again to specify other servers and users.

6 Repeat this procedure for each NDMP host that NetBackup backs up.

Configuring a policy to use NDMP with Replication Director

Before NetBackup can perform NDMP backups, it must have access to the NDMP host. Make sure that you've added the NDMP host credentials so that NetBackup can access the NDMP host.

See “Authorizing NetBackup access to the NDMP host” on page 112.

To create an NDMP policy for use with Replication Director

1 In the NetBackup Administration Console, in the left pane, expand NetBackup Management > Policies.

2 On the Actions menu, click New > New Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box. See “NetBackup naming conventions” on page 28.

4 Clear the Use Policy Configuration Wizard checkbox.

Note: Do not use the Policy Configuration Wizard or the Getting Started Wizard to configure a policy for Replication Director.

5 Click OK.

6 Configure the options on the policy Attributes tab:

Policy type For NetBackup to perform NDMP backups, select Standard, MS-Windows, or NDMP.
Data classification
(Optional for Replication Director.) The data classification of the policy must match the data classification of the SLP selected for the backup.

Policy storage
Select the SLP that you want to use that has been configured for snapshot replication.

Replication Director provides the ability to duplicate a NAS snapshot when the Backup From Snapshot operation is included in the SLP.

See “Backup From Snapshot operation” on page 95.

Note: The Index From Snapshot operation is not supported for any policy that uses NDMP. (For example, an NDMP policy, or a Standard or MS-Windows policy with NDMP Data Mover enabled.)

See “Index From Snapshot operation” on page 92.

Perform snapshot backups
Enable Perform snapshot backups so that the policy takes snapshots of the array.

This option must be enabled for Replication Director configuration.

OST_FIM snapshot method
Click Options. From the Snapshot method drop-down menu, select OST_FIM. The options that appear depend on the selected policy type.

Note: The OST_FIM method works only if the Policy storage attribute points to a storage lifecycle policy that contains a snapshot-capable storage unit.

The OST_FIM method provides two configuration parameters:
<table>
<thead>
<tr>
<th>Snapshot Type configuration parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>0-Auto</strong></td>
<td>This parameter indicates to the partner to use the best snapshot technology available to that particular partner to create the snapshot. For example, when 0 is indicated, the OpenStorage partner NetApp selects <strong>3-Diff</strong>.</td>
</tr>
<tr>
<td><strong>1-Clone</strong></td>
<td>This parameter indicates to the partner to create an independent copy of the volume. The copy process can take some time as the entire copy must be complete. The snapshot that is created is independent of the source.</td>
</tr>
<tr>
<td><strong>2-Plex</strong></td>
<td>This parameter indicates to the partner to create a snapshot that is completely independent of the source snapshot. This parameter is based on mirror-break-off technology. When a mirror device is attached to the source, the contents of the mirror device is exactly the same as the source device. When the relationship is broken between the two, the mirror device is separated from the source. The mirror device acts as a point-in-time copy.</td>
</tr>
<tr>
<td><strong>3-Diff</strong></td>
<td>This parameter indicates to the partner to create a snapshot that is completely dependent on the source. This parameter is based on copy-on-write technology. The device creates a cache object to maintain the original blocks of the snapshot when the blocks are modified.</td>
</tr>
</tbody>
</table>

For more information on each snapshot type, see the NetBackup Snapshot Client Administrator's Guide.

<table>
<thead>
<tr>
<th>Maximum Snapshots configuration parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This parameter sets the maximum number of Instant Recovery snapshots to be retained at one time. When the maximum is reached, the next snapshot causes the oldest to be deleted.</td>
<td></td>
</tr>
</tbody>
</table>

Click OK to save the configuration and close the Snapshot Client Options dialog box.

<table>
<thead>
<tr>
<th>Retain snapshots for Instant Recovery</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable this option for a snapshot-only backup, or to keep the snapshot after the backup completes.</td>
<td></td>
</tr>
</tbody>
</table>

This option must be enabled for Replication Director configuration.
Collect true image restore information with move detection

This option is not supported in SLPs that are configured for snapshots and snapshot replication.

Perform off-host backup

Enable this option for an NDMP policy.

The following options must also be configured for an NDMP policy:

- From the Use drop-down menu, select Data Mover.
- From the Machine drop-down menu, select NDMP.

See Figure 8-2 on page 119.

For descriptions of all policy options, see the NetBackup Administrator's Guide, Volume I or the online Help.

7. Select the Schedules tab and configure the schedules as you would for any other policy.

See the NetBackup Administrator's Guide, Volume I or the online Help.

8. Select the Clients tab and specify the client or the array.
9 Select the **Backup Selections** tab to indicate the path to the array. The format is vendor-specific.

The following is a client entry and backup selection from the viewpoint of the client:

![Client Entry and Backup Selection]

The following is a client entry and backup selection from the viewpoint of the array:

![Array Viewpoint]

10 When the policy configuration is complete, click **OK**.
Configuring backup policies to create snapshots and snapshot replication

About NDMP support for Replication Director

Figure 8-2  Policy configuration for NDMP snapshots
Configuring backup policies to create snapshots and snapshot replication

About NDMP support for Replication Director
Restoring from a snapshot

This chapter includes the following topics:

- About restores from array-based snapshots
- Restoring files and folders from an array-based snapshot
- Using OpsCenter to restore from array-based snapshots
- How NetApp performs a volume-level rollback restore
- Restoring (rolling back) from an array-based snapshot

About restores from array-based snapshots

NetBackup manages array-based snapshot creation and replication. NetBackup also can create backup images from those snapshots.

See “About configuring storage lifecycle policies for snapshots and snapshot replication” on page 79.

In this release of NetBackup, you can do the following restore operations from an array-based snapshot:
File-level restore from the snapshot

NetBackup directs the storage device to restore individual files or folders from the snapshot. The storage device moves the data on the storage device.

Several methods exist for file-level restore from a snapshot, a replica, or a backup, as follows:

- The Backup, Archive, and Restore interface.
  See “Restoring files and folders from an array-based snapshot” on page 122.
- The NetBackup `bprestore` command.
  See the NetBackup Commands Reference Guide.
- The Symantec OpsCenter interface.
  See “Using OpsCenter to restore from array-based snapshots” on page 127.

File-level restore from the snapshot is possible only when either the Index From Snapshot or the Backup From Snapshot SLP operation is performed on the snapshots.

Volume-level rollback restore from the snapshot (copy one)

NetBackup directs the storage device to replace the volume with the snapshot of the volume. The storage device may be able to restore the volume without moving data.

See “How NetApp performs a volume-level rollback restore” on page 127.

See “Restoring (rolling back) from an array-based snapshot” on page 128.

Note: The NetBackup 7.5 release supports snapshot restore of copy one only to the primary site. To restore at a remote site, use file-level restore.

The NetBackup Replication Director enables the array snapshots, replications, and restores.

Replication Director snapshots use the OST_FIM snapshot method. The snapshots also must be enabled for instant recovery by the Retain snapshots for Instant Recovery option of the backup policy.

Only a system administrator can perform an array-based restore.

Restoring files and folders from an array-based snapshot

This topic describes how to restore individual items from array-based snapshots.
The **Backup, Archive, and Restore** client interface displays the files and folders from the primary backup copy.

See “About restores from array-based snapshots” on page 121.

**To restore files and folders from an array-based snapshot**

1. Start the restore, as follows:

   **UNIX and Linux**
   - Click the **Restore Files** tab.
   - In the **Restore type** drop-down list, select **Normal Backups**.
   - Click **View > Refresh**.

   **Windows**
   - Click **File > Select Files and Folders to Restore** and select either from **Normal Backup**.

The following is an example of the restore window on a Windows computer:
2 Select a snapshot as follows:

UNIX and Linux  
In the Date Range dialog box, select a snapshot from the list and click OK. 
The snapshot contents appear in the Directory Structure pane.

Windows  
In the NetBackup History pane, select the snapshot to restore. 
The snapshot appears in the All Folders pane.

3 To select the items that you want to restore, expand the directory tree to find the items to restore and then click the check box next to the items.

4 To set up how to restore the selected items, do the following:

■ On UNIX systems, click Restore.
■ On Windows systems, click Actions > Start Restore of Marked Files.

The following is an example of the Restore Marked Files dialog box on a Microsoft Windows computer:
5 In the **Restore Marked Files** dialog box, select from the following options to meet the requirements for the restore:

**Restore Destination Choices**

Select one of the following destination options:

- Restore everything to its original location (default)
- Restore everything to a different location (maintaining existing structure)
- Restore individual directories (folders) and files to different locations
- Create and restore to a new virtual hard disk file (Windows systems only)

For details about each option, see the Backup, Archive, and Restore online Help.
**Restore Options**  
Select from the following restore options:
- **Overwrite existing files.**
- **Restore without access control attributes** (Windows clients only).
- **Rename hard links** (UNIX clients only).
- **Rename soft links** (UNIX clients only).
- **Restore the file using a temporary file name.**
- **Do not restore the file** (default).

For details about each option, see the Backup, Archive, and Restore online Help.

**Job Priority**  
You can change the priority of this restore by clicking **Override default priority**, and then set a priority number.

The default is 90000. The available range is 0 to 99999. Higher numbers are higher priority.

For details about this option, see the Backup, Archive, and Restore online Help.

**Use default progress log filename**  
UNIX clients only.

By default, progress log messages are written to the following location on the UNIX client:

```
/usr/openv/netbackup/logs/user_ops/loginID/logs
```

To change the location and the name of the progress log file for this backup, take the following actions:
- Click this check box to remove the check mark.
- In the **Progress log filename** field, enter a new path and file name.

For details about this option, see the Backup, Archive, and Restore online Help.

6  
Click **Start Restore**.

7  
To view the restore progress, do the following:
- On Windows systems, in the **View Status** dialog box that appears, click **Yes**.
- On UNIX systems, in the **Task Progress** tab that appears, click **Yes**.

The restore may take a few minutes to complete. After you start a restore operation, you can close **Backup, Archive, and Restore** and perform other tasks. NetBackup continues the operation in the background.
Using OpsCenter to restore from array-based snapshots

Replication Director enables administrators to use the Restore operation in OpsCenter to browse and restore files and directories from any copy of a snapshot that is created as part of a storage lifecycle policy, even those in long-term storage. The Restore operation in OpsCenter also offers greater flexibility with the advanced search capabilities.

To use Restore operation in OpsCenter requires that the Index From Snapshot operation was used in the SLP that generated the snapshots and replications.

See “Index From Snapshot operation” on page 92.

For more information on the Restore operation in OpsCenter, see the Symantec OpsCenter Administrator's Guide.

How NetApp performs a volume-level rollback restore

NetBackup directs the array storage device to do a volume-level rollback restore of the snapshot. The device determines how to accomplish the restore. Several factors affect how the array accomplishes the restore, as follows:

- The NetBackup Force rollback even if it invalidates later snapshots restore option.
- Whether or not the snapshots were replicated.
- The interaction between the primary and secondary SnapVault devices.

See Table 9-1.

Table 9-1  Volume-level rollback restore factors

<table>
<thead>
<tr>
<th>Volume-level rollback restore</th>
<th>Force rollback even if it invalidates later snapshots</th>
<th>More recent snapshots have been replicated</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the most recent snapshot</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>The device performs a rollback restore of the volume. Because it is a rollback restore, the restore occurs almost immediately.</td>
</tr>
</tbody>
</table>
Table 9-1  Volume-level rollback restore factors *(continued)*

<table>
<thead>
<tr>
<th>Volume-level rollback restore</th>
<th>Force rollback even if it invalidates later snapshots</th>
<th>More recent snapshots have been replicated</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From an older snapshot</td>
<td>Enabled</td>
<td>No</td>
<td>The device performs a rollback restore of the volume. Because it is a rollback restore, the restore occurs almost immediately. Because the rollback restore replaces the current volume with the older snapshot, more recent snapshots are lost.</td>
</tr>
<tr>
<td>From an older snapshot</td>
<td>Enabled</td>
<td>Yes</td>
<td>The device performs a file-level restore of the entire volume rather than a volume-level rollback restore. Such a restore is much slower than a volume-level rollback restore in which no data moves. Unlike a volume-level rollback restore, this type of restore does not destroy more recent snapshots.</td>
</tr>
<tr>
<td>From an older snapshot</td>
<td>Disabled</td>
<td>No</td>
<td>The restore fails.</td>
</tr>
<tr>
<td>From an older snapshot</td>
<td>Disabled</td>
<td>Yes</td>
<td>The device performs a file-level restore of the entire volume rather than a volume-level rollback restore. Such a restore is much slower than a volume-level rollback restore in which no data moves. Unlike a volume-level rollback restore, this type of restore does not destroy more recent snapshots.</td>
</tr>
</tbody>
</table>

**Restoring (rolling back) from an array-based snapshot**

The following procedure describes how to perform a volume-level rollback restore from a snapshot that is managed by NetBackup Replication Director. The storage device replaces the protected volume with the snapshot of the volume.

This release of NetBackup supports rollback restore from copy one only. Therefore, the Backup, Archive, and Restore interface shows the copy one snapshot only. If
copy one is expired, the interface does not show any of the copies (that is, replicas) of the snapshot (if any exist).

See “About restores from array-based snapshots” on page 121.

See “How NetApp performs a volume-level rollback restore” on page 127.
To restore from an array-based snapshot

1. Begin the restore procedure as follows:

   - **UNIX and Linux**: Click the **Restore Files** tab, then select **Point in Time Rollback** for the **Restore Type**.
     The **Date Range** dialog box appears.

   - **Windows**: Click **File > Select Files and Folders to Restore > from Point in Time Rollback**.
     The **NetBackup History** pane shows the available snapshots from which you can restore.

The following is an example of the restore window on a Windows computer:
2 Select a snapshot as follows:

UNIX and Linux In the Date Range dialog box, select a snapshot from the list and click OK.

The snapshot contents appear in the Directory Structure pane.

Windows In the NetBackup History pane, select the snapshot to restore.

The snapshot appears in the All Folders pane.

3 Select the volume, as follows:

UNIX and Linux In the Directory Structure pane, expand the directory tree to find the volume mount point (if necessary) and then click the check box next to the mount point for the volume.

Windows In the All Folders pane, expand the directory tree to find the volume mount point (if necessary) and then click the check box next to the mount point for the volume.
4 Begin the restore, as follows:

UNIX and Linux  Click **Restore**.

Windows  Click **Actions > Restore**....

The **Restore Marked Files** dialog box appears. Most options are selected by default and cannot be changed.

The following is an example of the **Restore Marked Files** dialog box on a Microsoft Windows computer:

![Restore Marked Files dialog box](image)

5 In the **Restore Marked Files** dialog box, select from the following options to meet the requirements for the restore:
## Restore Options

- **Skip verification and force rollback**
  By default, NetBackup performs several checks on the file system during the restore. If the checks fail, the restore stops. Select this option to skip verification.

  **Warning:** Select this option only if you are sure that you want to replace all of the files in the original location with the snapshot. Rollback deletes all files that were created after the creation-date of the snapshot from which you restore.

- **Force rollback even if it invalidates later snapshots**
  This option applies only if you restore from a snapshot other than the most recent one.

  **Warning:** Select this option only if you are sure that you want to replace the original volume with the snapshot. If more recent snapshots that have been replicated exist and you do not select this option, the rollback restore fails.

  See "How NetApp performs a volume-level rollback restore" on page 127.

## Job Priority

To change the priority of this restore, click **Override default priority** and then set a priority number.

The default is 90000. The available range is 0 to 99999.

## Use default progress log file name

UNIX and Linux systems only.

By default, progress log messages are written to the following location on the UNIX client:

`/usr/openv/netbackup/logs/user_ops/loginID/logs`

To change the location and the name of the progress log file for this restore, do the following:

- Click this check box to remove the check mark.
- In the **Progress log filename** field, enter a new path and file name.

6 Click **Start Restore**.

7 In the dialog box that appears, click **Yes** to view the restore status.

If file verification fails, a message appears in the **View Status** dialog box (Windows) or **Task Progress** tab (UNIX) that indicates the restore was not performed.

After you start a restore operation, you can close **Backup, Archive, and Restore** and perform other tasks on your computer. NetBackup continues the restore operation in the background.
Restoring from a snapshot

Restoring (rolling back) from an array-based snapshot
This chapter includes the following topics:

- Symantec OpsCenter reporting
- Configuring alerts for OpenStorage events
- Storage lifecycle policy reporting
- Disk pool monitoring
- Monitoring snapshot replication jobs
- Reporting on storage units, storage unit groups, and storage lifecycle policies

Symantec OpsCenter reporting

Use Symantec OpsCenter to provide unified reporting on Replication Director-related activity. This includes monitoring the lifecycle of the snapshot copies at the various storage locations. Administrators can use this information to help make retention-related decisions.

Symantec OpsCenter offers the following reports:

- Storage space utilization
- Capacity planning reports that display forecasted and historical views.

Configuring alerts for OpenStorage events

The administrator can configure OpsCenter to send alerts based on OpenStorage events:

- The DataFabric Manager server can generate threshold or *Volume Almost Full* alarms.
The DataFabric Manager server can generate alerts about **FlexVol Autogrow** or **Dataset member resized**.

Alerts based on the auto-discovery of unprotected NAS file services data. As with other OpsCenter alerts, the administrator can configure the following aspects of the alerts:

- Whether the event is an error, an informational notification, or a warning.
- Who receives an email about the alert.
- The severity of the alert.
- For which master servers the alert configuration applies.

See the *Symantec OpsCenter Administrator's Guide* for information about configuring alerts.

### Storage lifecycle policy reporting

The **Storage Lifecycle Policy** status report provides a summary of the SLPs of a selected master server.

Many columns in the report contain data that links to additional reports:

- **SLP Status by SLP**
- **SLP Status by Client**
- **SLP Status by Image**
- **SLP Status by Image Copy**

The **SLP Status by Image Copy** report displays the details of any snapshot copy that is a part of a SLP.

*Figure 10-1* shows the **Format** column, which identifies the image copy format as either NetBackup backup images or snapshot copy images. It also displays the **Lag Time** value, which is calculated based on the data collected from EMM database and catalog.
Disk pool monitoring

To view disk pool details, select the Monitor tab, and then the Devices subtab. Select the Disk Pools tab above the table. Disk pool monitoring is divided into three tabs:

**General** tab

The General tab (Figure 10-2) contains information about the selected disk pool, including the used and available space in the selected disk pool and whether the images in the disk pool have been imported.

The table also contains the following columns that pertain to snapshot replication:

- **Configured for Snapshots**
  Identifies whether the disk pool is configured to contain snapshots, making it eligible for snapshot replication.
- **Mirror**
- **Primary**
- **Replication**
The **Disk Volume** tab contains information about the selected disk pool, including the location or path to the volume, and whether the volume is configured for snapshots.

The **Storage Server** tab (Figure 10-3) contains information about the selected disk pool, including the server type and the number of active jobs for the storage server.

The table also contains a **Configured for Snapshots** column, which identifies whether the storage server is configured to contain snapshots.

**Figure 10-2**  Disk Pool General tab
Monitoring snapshot replication jobs

To view the details of snapshot replication jobs, select the **Monitor** tab, and then the **Jobs** subtab.

From the drop-down **Filter** menu, select **Snapshot Replication** (Figure 10-4) to display only those jobs generated from snapshot replication.

The **General** tab displays details about the selected job, including the duplication method (**Method**) used to create the backup and the data transferred for each job (**Job Size**).
Reporting on storage units, storage unit groups, and storage lifecycle policies

To view the details of storage units, storage unit groups, and storage lifecycle policies, select the **Manage** tab, and then the **Storage** subtab.

Select the **Storage Unit** tab above the table to display storage unit details, including whether the storage unit is enabled for snapshots and the name of the disk pool to which the storage unit belongs.

**Storage Unit** tab  The **General** tab (Figure 10-5) contains information about the selected storage unit. The table also contains the following columns that pertain to snapshot replication:

- **Configured for Snapshots**
  Identifies whether the storage unit is configured to contain snapshots, making it eligible for snapshot replication.
- **Mirror**
- **Primary**
- **Replication**

**Storage Unit Group** tab  The **Storage Unit Group** tab contains information about the selected storage unit group. The table contains a **Configured for Snapshots** column which identifies whether the storage unit group can contain snapshots.
Storage Lifecycle Policy tab

- **General**
  Displays SLP details, including whether the SLP is configured to preserve multiplexing, and the data classification on the SLP.

- **Storage Destinations**
  Displays the operation type and storage unit that is assigned to each operation in the SLP.

**Figure 10-5** Storage Unit General tab
OpsCenter reporting

Reporting on storage units, storage unit groups, and storage lifecycle policies
Terminology

This chapter includes the following topics:

- Replication terminology

Replication terminology

Use the following table as a reference for understanding many terms that are used frequently when describing replication processes.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup</td>
<td>The process of creating a copy of user data and creating backup or snapshot images of the data.</td>
</tr>
<tr>
<td></td>
<td>- The process of creating a new backup (tar) image of the client's data.</td>
</tr>
<tr>
<td></td>
<td>- The process of creating a snapshot of the client's data.</td>
</tr>
<tr>
<td>Copy</td>
<td>An instance of a NetBackup image which can stand alone; it can be read or deleted without affecting any other copy.</td>
</tr>
<tr>
<td>Data movement</td>
<td>A copy operation as performed by a third-party copy device or NetBackup media server.</td>
</tr>
<tr>
<td>Data mover</td>
<td>The host or entity that manages the backup or snapshot on behalf of the NetBackup client. The data mover can be either the NetBackup media server, a third-party copy device, a NAS filer, or a storage server.</td>
</tr>
<tr>
<td>Device</td>
<td>A general term for any of the following: LUN, logical volume, appliance, disk array.</td>
</tr>
<tr>
<td>Disk array</td>
<td>A disk storage array which exposes LUNs (block device) or network shares (file system) to a host server over SAN, NFS, CIFS, or iSCSI protocols.</td>
</tr>
<tr>
<td>Domain</td>
<td>See NetBackup domain.</td>
</tr>
</tbody>
</table>
## Table 11-1  Replication terms (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplication</td>
<td>NetBackup creates a copy by using a media server to move the data or by using the optimized duplication method.</td>
</tr>
<tr>
<td>FIM</td>
<td>Frozen Image Method. See OST_FIM.</td>
</tr>
<tr>
<td>Image</td>
<td>See backup image.</td>
</tr>
<tr>
<td>Instant recovery</td>
<td>Sometimes called Persistent Frozen Image (PFI).</td>
</tr>
<tr>
<td>Local domain</td>
<td>The domain in which the storage device resides and in which it is configured.</td>
</tr>
<tr>
<td>Mirror</td>
<td>This term can mean either of the following:</td>
</tr>
<tr>
<td></td>
<td>■ A disk that maintains an exact copy (duplicate or replica) of another disk. A mirror disk is often called a secondary, and the source disk is called the primary. All writes to the primary disk are also made to the mirror disk.</td>
</tr>
<tr>
<td></td>
<td>■ A type of snapshot that is captured on a mirror disk. At the appropriate moment, all further writes to the primary disk are held back from the mirror, which splits the mirror from the primary. As a result of the split, the mirror becomes a snapshot of the primary. The snapshot can then be backed up.</td>
</tr>
<tr>
<td>Mount host</td>
<td>A NetBackup host with a compatible operating system and the necessary software to mount a snapshot to perform browse, restore, and snap-to-archive duplication operations. This is the host that has the mount point on the storage.</td>
</tr>
<tr>
<td>NetApp Plug-in for Symantec NetBackup</td>
<td>Also referred to as the NBUPlugin, this plug-in communicates with the OSTPlugin, using the XML-based messaging SOAP protocol to query the DataFabric Manager server. The NetApp Plug-in 1.0 for Symantec NetBackup Installation and Administration Guide is available from the NetApp Support Site.</td>
</tr>
<tr>
<td>NetBackup domain</td>
<td>A NetBackup installation with one master server and one or more media servers and clients. A single NetBackup domain may span more than one site or location. That is, the media servers and clients of a single NetBackup master server may not all be at same site where the master server resides.</td>
</tr>
<tr>
<td>NetBackup OpenStorage Plug-in for Replication Director</td>
<td>Also referred to as the OSTPlugin, this plug-in from NetBackup communicates with the NBUPlugin, using the XML-based messaging SOAP protocol to query the DataFabric Manager server.</td>
</tr>
<tr>
<td>OST_FIM</td>
<td>The name of the snapshot method that is selected in a policy configured for snapshot replication using Replication Director. The name represents OpenStorage Frozen Image Method.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Primary volume</td>
<td>A unit of storage space that a disk array exposes to a host in the form of a network share (NFS or CIFS) or LUN block device. Primary volumes store an application’s active data.</td>
</tr>
<tr>
<td>OST device</td>
<td>A storage server that has implemented the OST plug-in interface.</td>
</tr>
<tr>
<td>Replica</td>
<td>A replica is a bit-by-bit block copy of the snapshot.</td>
</tr>
<tr>
<td>Replication</td>
<td>The process of replicating a snapshot onto a separate disk array using NetBackup Replication Director.</td>
</tr>
<tr>
<td>Replication Director</td>
<td>A Symantec NetBackup product used to manage snapshot replication as a disaster recovery solution.</td>
</tr>
<tr>
<td>Replication source</td>
<td>A NetBackup-configured disk pool and storage unit that contains volumes that serve as the source for subsequent replications.</td>
</tr>
<tr>
<td>Replication target</td>
<td>A NetBackup-configured disk pool and storage unit that can receive or accept replications from a replication source.</td>
</tr>
<tr>
<td>Rollback</td>
<td>An operation that restores data to the original location from a snapshot, specifically where the data movement is performed by the storage device.</td>
</tr>
<tr>
<td>Snapshot</td>
<td>A point-in-time, read-only, disk-based copy of a client volume. A snapshot is created with minimal impact on other applications. NetBackup provides several types of snapshots, depending on the device where the snapshot occurs. An image copy that is a snapshot is also considered a replica. A snapshot copy consists of one or more snapshot fragments.</td>
</tr>
<tr>
<td>Snapshot method</td>
<td>A set of routines for creating a snapshot. The NetBackup administrator can select the method, or let NetBackup select it when the snapshot begins (auto method).</td>
</tr>
<tr>
<td>Snapshot mirror</td>
<td>A disk mirror that is an exact replica of a primary volume at a particular moment, reproduced on a physically separate device.</td>
</tr>
<tr>
<td>Snapshot source</td>
<td>The production data (file system, raw partition, or logical volume) to which a snapshot method is applied. NetBackup automatically selects the snapshot source according to the entries in the Backup Selections list of the snapshot policy.</td>
</tr>
<tr>
<td>Storage device</td>
<td>See Disk Array.</td>
</tr>
<tr>
<td>Storage lifecycle policy (SLP)</td>
<td>NetBackup uses storage lifecycle policies to manage the lifecycle of a backup or snapshot image. An SLP controls the image migration, duplication, and replication within a single NetBackup master server domain.</td>
</tr>
</tbody>
</table>
### Table 11-1 Replication terms (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit</td>
<td>A storage unit is configured for one of two types of data:</td>
</tr>
<tr>
<td></td>
<td>- Backup storage units contain backup images. A backup storage unit cannot contain snapshots.</td>
</tr>
<tr>
<td></td>
<td>- Snapshot storage units contain snapshots. A snapshot storage unit cannot contain backups. Replication Director uses snapshot storage units in snapshot replication configurations.</td>
</tr>
<tr>
<td>Storage server</td>
<td>A storage device configured in NetBackup. It is a NetBackup entity that represents a disk array.</td>
</tr>
</tbody>
</table>
Troubleshooting

This chapter includes the following topics:

- Identifying the version of the NetApp Plug-in for Symantec NetBackup
- Throttling Replication Director operations with NetBackup
- Disk Pool Configuration Wizard error
- Standard policy restore error (2800)
- Problems due to the use of an unsupported NetApp topology
- Status 156 errors
- Policy validation issues
- Replication issues
- Duplication issues
- Assorted issues
- Generating more detailed logs

**Identifying the version of the NetApp Plug-in for Symantec NetBackup**

See the following TechNote to learn how to identify the version of the NetApp Plug-in for Symantec NetBackup:

Throttling Replication Director operations with NetBackup

NetBackup offers three parameters to control or throttle Replication Director operations.

- **Disk pool Limit I/O streams setting**
  The Limit I/O streams setting appears in the New or Change Disk Pool dialog box. The setting controls the number of NetBackup jobs that can use a disk pool concurrently.
  By default, the Limit I/O streams checkbox is clear (not enabled), so there is no limit to the jobs that use a disk pool concurrently. Note that the Limit I/O streams setting must be expressed in increments of 2, as that is the number of I/O resources that are required by a single replication job.
  For example, consider a situation in which the Limit I/O streams is set to 4 for the disk pool that contains the PrimarySnapshot LSU. This means that two concurrent replication jobs can be active in NetBackup, assuming that no batching is occurring. If a third replication job starts, it will be queued until one of the first two replication jobs is complete. The NetBackup Job Manager queues the third job until one of the two running jobs is complete.
  Batching can cause many replications to occur within a single NetBackup job. For this reason, another setting may be required in tandem with Limit I/O streams, as described below.

- **Global storage lifecycle policy configuration using the LIFECYCLE_PARAMETERS file**
  The LIFECYCLE_PARAMETERS file is not present by default. The administrator must create the file in the following location, add the desired settings, and then restart the NetBackup services.
  **UNIX:**
  /usr/openv/netbackup/db/config/LIFECYCLE_PARAMETERS
  **Windows:**
  `install_path\NetBackup\db\config\LIFECYCLE_PARAMETERS`
  Add the MAX_IMAGES_PER_SNAPSHOT_REPLICATION_JOB entry to the LIFECYCLE_PARAMETERS file to control Replication Director job throughput as follows:
  MAX.Images_PER_SNAPSHOT.REPLICATION_JOB = 50
  By default, the value is 50, even if the file does not exist or does not contain this entry. The value of the entries in the LIFECYCLE_PARAMETERS file applies to all SLPs. This setting applies only to snapshot replication jobs that are batched together.
Batching combines replications for multiple Backup IDs (spanning policies and clients) whenever:

■ The source and the target storage units are the same.

■ The replication types are the same (mirror or non-mirror).

■ The copy numbers are the same.

The scalability issue this can cause is that the NetBackup media manager can send a large number of nearly simultaneous snapshot replication requests to the NetApp Plug-in for Symantec NetBackup which can overwhelm either the plug-in or the DataFabric Manager.

This setting can control how many NetBackup BIDs (BackupIDs) can be batched together into a single replication job.

Based on the previous example of setting the disk pool **Limit I/O streams** limit, add the LIFECYCLE_PARAMETERS file setting:

■ Disk pool **Limit I/O streams** is set to 4 for the disk pool containing the `PrimarySnapshot` LSU.

■ The **MAX_IMAGES_PER_SNAPSHOT_REPLICATION_JOB** entry in the LIFECYCLE_PARAMETERS file is set to 10:

  \[
  \text{MAX\_IMAGES\_PER\_SNAPSHOT\_REPLICATION\_JOB} = 10
  \]

■ Suppose that a duplication session starts and 25 BIDs are pending replication for copy number 2.

  ■ Two replication jobs start, each for replicating 10 BIDs.

  ■ A third job is queued by the Job Manager: a replication job (for the remaining 5 BIDs). The job waits until one of the first two jobs completes.

For additional information about the LIFECYCLE_PARAMETERS file and the various entries, see the *NetBackup Administrator's Guide, Volume I*.

■ **bpdm touchfile to control the asyncWaitSnap interval**

During a batched replication job, **bpdm** calls `asyncWait` on all snapshots for all BIDs in succession. It then sleeps for a timeout value specified by the vendor as a return value to the `asyncWaitSnap` API before it makes another round of wait calls.

Because of the timeout, it can take up to 60 seconds for NetBackup to discover that a replication has completed. To increase job throughput at the expense of the DataFabric Manager load, this timeout value can be adjusted by creating the following file:

```
/usr/openv/netabackup/db/config/RPL_ASYNC_WAIT_SLEEP
```

The file should contain one line with a number that represents the number of seconds to use for this interval. The default value for the NetApp Plug-in for Symantec NetBackup is 60 seconds.
The setting takes effect the next time `bpdm` starts as part of a replication job.

- By default a snapshot creation job consumes one (1) I/O stream on the primary disk pool. There is another setting whereby a user can cause snapshot creation to consume zero I/O resources:
  Add the following to the `bp.conf` file:

  ```
  REQUEST_STU_RESOURCE_FOR_SNAPSHOT_JOBS = NO
  ```
  Then, restart services.

- A snapshot replication job consumes two (2) I/O streams on the source disk pool and zero (0) on the target.

## Disk Pool Configuration Wizard error

The following error message appears during the Disk Pool Configuration Wizard if multiple DataFabric Manager servers are configured within one domain:

Invalid command parameter(20)
RDSM has encountered an STS error: `getDiskVolumeInfoList`.

## Standard policy restore error (2800)

The following table describes the restore problems that can result in a status code 2800 and possible solutions:

<table>
<thead>
<tr>
<th>Standard policy restore error (2800).</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The administrator attempts to restore a backup to its original location. However, the NetApp volume fails with a status code 2800. The progress log displays the message: No space left on device.</td>
<td>The NetApp volume on which the snapshot resides must have enough free space for the restore to succeed. Even if the <strong>Overwrite existing files</strong> option is selected, the free space must equal more than the original backup size. The size requirement exists because the data blocks that correspond to the old file cannot be deleted while the snapshot refers to them.</td>
</tr>
<tr>
<td>The restore fails with a permission denied error while copying files to the primary volume.</td>
<td>The time on the NetBackup servers, the DataFabric Manager server, and the filer must be synchronized or have a difference of less than 5 minutes.</td>
</tr>
</tbody>
</table>
Table 12-1 Solutions for status code 2800 (continued)

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The restore from a snapshot fails with status code 2800. The progress log displays the message: no files matched in the given data range</td>
<td>The restore fails if you select a different path other than what is listed in the Backup Selections tab of the policy. For example, vol6 and vol7 are volumes mounted on /mnt/vol6 and /mnt/vol7 respectively. These mount points are specified in the Backup Selections tab. During a restore, if you select only /mnt, (the parent directory of the path that is listed in the Backup Selections tab), the restore fails with status code 2800. To successfully restore from the snapshot copy, select the original path that is listed in the Backup Selections tab. In this example, specify /mnt/vol6 and /mnt/vol7 or the subdirectory or file. For more information on restoring snapshots, see the NetBackup Snapshot Client Administrator’s Guide.</td>
</tr>
</tbody>
</table>

Snapshot-based backups and restores fail if the backup selection that is listed in the NetBackup policy contains any spaces either in the mount points or mount devices. |
| ■ No spaces in mount points  
Block device example:  
/dev/dg/vol is mounted on /mnt point  
NFS example:  
Filer:/vol/datavol is mounted on /nfs mnt  
■ No spaces in mount devices  
Block device example:  
/dev/dg/vol data is mounted on /mntpoint  
NFS example:  
Filer:/vol/data vol is mounted on /nfsmnt |

Problems due to the use of an unsupported NetApp topology

Snapshot replication supports many possible permutations of the following NetApp topologies. All begin with a snapshot of the data on the primary volume.
<table>
<thead>
<tr>
<th>Representation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot can be replicated using SnapVault.</td>
</tr>
<tr>
<td>SnapVault</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Secondary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot can be replicated using SnapMirror.</td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Secondary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot can be replicated using SnapMirror, and then replicated again using SnapVault.</td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Secondary storage</td>
<td></td>
</tr>
<tr>
<td>SnapVault</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Tertiary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot can be replicated using SnapMirror, and then replicated again using SnapMirror.</td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Secondary storage</td>
<td></td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Tertiary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot can be replicated using SnapVault, and then replicated again using SnapMirror.</td>
</tr>
<tr>
<td>SnapVault</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Secondary storage</td>
<td></td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Tertiary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Two examples of many supported configurations:</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td>The snapshot replications can fan out to two or three resource pools.</td>
</tr>
<tr>
<td>SnapVault</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Tertiary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
<tr>
<td>Or:</td>
<td></td>
</tr>
<tr>
<td>Data ─► Snapshot</td>
<td></td>
</tr>
<tr>
<td>SnapVault</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>SnapMirror</td>
<td></td>
</tr>
<tr>
<td>Snapshot copies</td>
<td></td>
</tr>
<tr>
<td>Tertiary storage</td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td></td>
</tr>
</tbody>
</table>

Table 12-3 lists the topologies that are not supported in this release.
### Table 12-3: Unsupported snapshot replication topologies

<table>
<thead>
<tr>
<th>Example of an unsupported configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One example of an unsupported configuration:</td>
<td>The snapshot can be replicated in succession, or cascaded, no more than two times.</td>
</tr>
<tr>
<td><img src="data/snapshot1.png" alt="Diagram 1" /></td>
<td>Snapshot replications can fan out to no more than three resource pools.</td>
</tr>
<tr>
<td><img src="data/snapshot2.png" alt="Diagram 2" /></td>
<td>Snapshot replications can fan out only from the primary snapshot.</td>
</tr>
<tr>
<td><img src="data/snapshot3.png" alt="Diagram 3" /></td>
<td>Snapshots in succession can accommodate any combination of SnapMirror and SnapVault, except from one SnapVault to another SnapVault.</td>
</tr>
</tbody>
</table>

Troubleshooting Problems due to the use of an unsupported NetApp topology
Jobs that result from an unsupported topology fail with an error 84 (media write error) status code. For a status 84, examine the logs of the NetApp Plug-in for Symantec NetBackup on the DataFabric Manager.

On UNIX:

/usr/NetApp/NAdaptor/trace/nadaptor_timestamp.log

On Windows:

Install_path/Program Files/NetApp/NAdaptor/trace/

The following log example describes an invalid topology in a replicate snapshot:

2 REPLICAT:6152 12 0 222230 2011/03/30 17:22:30
check_topology : BEGIN

0 REPLICAT:6152 211 0 222230 2011/03/30 17:22:30
ntap_dfm_replicate_snapshot : Unable to find the topology

1 STRWIDE :6152 1 0 222230 LFB:
Need 39 chars to store wide copy of UTF8 'Invalid topology in replicate snapshot'

1 NALOG :6152 494 0 222230 2011/03/30 17:22:30
Logging message to NT System Event Viewer

0 REPLICAT:6152 219 0 222230 2011/03/30 17:22:30
ntap_dfm_replicate_snapshot : END

Status 156 errors

The following situations can cause Status 156 errors:

- A NetBackup client (mount host) must be able to contact the NetApp storage using the DNS name. If the client cannot contact the NetApp storage using the DNS name, the snapshot job and the restore jobs from both the snapshot and the replicated snapshot will fail with a Status 156. From the NetBackup client, make sure that you can ping the NetApp storage system as follows:

  ping <filer_dnsname>

- To perform alternate client backups and restores for a Windows client, log into the NetBackup Client Service as the Administrator account, not as the Local system account. If the Local system account is selected, the backup fails with status 156.
Perform the following actions for both the local client and the alternate client:

- In **Windows Services**, double-click the NetBackup Client Service.
- Select the **Log On** tab. If the service is not logged on as Administrator, stop the service.
- Change the logon to the Administrator account and restart the service.
- Retry the backup or restore.

- A live browse restore from the mirror copy fails.

Before creating any snapshots, perform the following on the volume on which the CIFS share is created:

- Create the volume. Then, use the NetApp `vol` command options to enable `convert_ucode` on. Setting the `convert_ucode` to on forces conversion of all directories to Unicode format when accessed from both NFS and CIFS.
- Begin to use the volume using CIFS or NFS to create snapshots.

- Regarding snapshot jobs that end with status code 156 or 1541 or other error. These errors may occur in the following situation: An administrator manually (or by using a script), starts multiple snapshot jobs at a high frequency. (For example, one snapshot job every 5 seconds.)

  At the same time, multiple rotation processes begin. The processes operate on the same catalog information, which includes information about existing snapshots. Because the processes work on the same information at the same time, a problem of inconsistency can occur. Some of the processes delete the snapshots and update the catalog while other processes continue to refer to the obsolete information. The result is that the snapshot jobs can end with status codes 156 (snapshot error encountered), 1541 (snapshot creation failed), or other unpredictable errors.

  This behavior does not occur for scheduled snapshot jobs, as NetBackup controls the job execution.

---

**Policy validation issues**

The following table describes various causes for policy validation failures and possible solutions:
Table 12-4  Policy validation issues

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The filers are not part of the NetBackup group.</td>
<td>Make sure that the resource pool is created and the aggregate on the filer where the data volume resides is added to the resource pool. Then add this resource pool to the NetBackup group.</td>
</tr>
<tr>
<td></td>
<td>Add the details of the DataFabric Manager server in the Operation Manager section of the filer.</td>
</tr>
<tr>
<td>The volume is not visible in the Operations Manager. That means that the DataFabric Manager server is not aware of the volume that was created on the filer.</td>
<td>Enable the SSH on filer. Restart the DataFabric Manager server or refresh the connection. The volume should be visible in Operations Manager on the DataFabric Manager server.</td>
</tr>
<tr>
<td>The filer and the DataFabric Manager server are in different domains.</td>
<td>Make sure the /etc/hosts file on both the filer and the DataFabric Manager server have entries for one another. Or, install the filer in the same domain.</td>
</tr>
<tr>
<td>The host credentials that are required to access a CIFS share are not set for the NetBackup Client Service (bpcd).</td>
<td>Set the credentials that are required to access a CIFS share in the NetBackup Client Service and restart the service.</td>
</tr>
<tr>
<td>Policy validation fails with status 223.</td>
<td>Make sure the data volume on the filer to back up is mounted on the client that is listed in the NetBackup policy.</td>
</tr>
<tr>
<td>Policy validation fails due to a problem with a specified volume.</td>
<td>Make sure that a volume or qtree in the backup selection of the policy is not offline. Also note that snapshot jobs remain in an active state if a volume or qtree in the backup selection is offline.</td>
</tr>
<tr>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SnapVault and SnapMirror options are not configured to access the</td>
<td>Configure the SnapVault and SnapMirror options on the source filer to access the vault and mirror from the target filer.</td>
</tr>
<tr>
<td>vault and mirror from the target filer.</td>
<td>(See below.)</td>
</tr>
<tr>
<td>Incorrect DataFabric Manager server configuration. (See below.)</td>
<td>(See below.)</td>
</tr>
</tbody>
</table>

To check the DataFabric Manager server configuration, run the following commands on the DataFabric Manager server. The output from each command should look like the following:

```
$ dfm option list pmUseSDUCompatibleSnapshotNames
Option                        Value
------------------------------------------
pmUseSDUCompatibleSnapshotNames Yes

$ dfm option list pmCustomNameUseQtreeList
Option                        Value
------------------------------------------
pmCustomNameUseQtreeList No

$ dfm option list pmCustomNameUseRetentionType
Option                        Value
------------------------------------------
pmCustomNameUseRetentionType No
```

If the output differs from the output shown here, run the following commands to correctly set it:

```
$ dfm option set pmCustomNameUseRetentionType=No

$ dfm option set pmCustomNameUseQtreeList=No

$ dfm option set pmUseSDUCompatibleSnapshotNames=yes
```
Duplication issues

The following table describes various causes for duplication of backup (tar) image failures and possible solutions:

Table 12-6 Duplication issues

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The snapshot import has failed. The NetApp Plug-in for Symantec NetBackup failed to export the snapshot volume. | Perform the following steps on the source volume:  
1. Create the volume and enable `convert_ucode` on and `create_ucode` on using `vol options` commands.  
2. Begin to use the volume using CIFS or NFS and create snapshots. |
| The credentials that are required to access a CIFS share are not set for the NetBackup Client Service (`bpcd`). | Set the credentials that are required to access a CIFS share in the NetBackup Client Service and restart the service. |
| A space [ ] appears in one of the backup selections. | Rename the backup selection, omitting the space. |

Assorted issues

The following table describes various problems and possible solutions:
### Table 12-7 Assorted troubleshooting issues

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Problems with policy validation, snapshot creation, and duplication. | The NetApp Plug-in for Symantec NetBackup is not installed properly. | 1. Check the installation logs of the NetApp Plug-in for Symantec NetBackup for errors and warnings. The log should contain no errors. Generally, if licenses are not installed on the DataFabric Manager server, the plug-in has not been installed properly. Before installing the plug-in, install the required licenses on the DataFabric Manager server. The install logs are available in the following location: `NBUPlugin_INSTALL_PATH\NBUPlugin_install.log`  

2. Make sure that the three plug-in processes are running: `nadapter_32`, `processmanager`, and `commnmanager`.  

Check the following directory: `NBUPlugin_INSTALL_PATH\processmanager\status`  

3. Check the plug-in logs available in the following file: `NBUPlugin_INSTALL_PATH\trace\adaptor*.log` |
| Job fails with PFI rotation error 13. | Some operations may take longer to complete due to network connectivity, causing jobs to time out and fail. | Consider increasing the `REQUEST_DELIVERY_TIMEOUT` configuration option from the default of 300 (5 minutes) to 900 (15 minutes).  

For example:  

`REQUEST_DELIVERY_TIMEOUT = 900`  

This option does not appear in the NetBackup Administration Console host properties. See the `NetBackup Commands Reference Guide` for information about using the `bpgetconfig` and the `bpsetconfig` commands to change the configuration option in the `bp.conf` file (UNIX) or the registry (Windows). |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot creation fails.</td>
<td>Snapshot creation fails if the maximum snapshot limit is reached and no catalog image is marked as SLP-complete. In this case, rotation of snapshot fails.</td>
<td>The SLP is marked as complete sometime after the job completes. To manually mark the SLP as complete, use the <code>nbstlutil new_session</code>, located here: <code>NBUPlugin_INSTALL_PATH/bin/admincmd</code></td>
</tr>
<tr>
<td>Snapshot creation fails.</td>
<td>The NetBackup_create_import_timestamp dataset may have been deleted.</td>
<td>To clear the failure, restart the NetApp Plug-in for Symantec NetBackup.</td>
</tr>
<tr>
<td></td>
<td>Check the log of the NetApp Plug-in for Symantec NetBackup for a message that includes the following information:</td>
<td>For example, type the following:</td>
</tr>
<tr>
<td></td>
<td>Import snap failed.</td>
<td><code>telnet array_name1</code></td>
</tr>
<tr>
<td></td>
<td>For example:</td>
<td><code>export LD_LIBRARY_PATH=/usr/NetApp/NBUPlugin/lib</code></td>
</tr>
<tr>
<td></td>
<td>0 IMGINFO :-245482608 98 0 154918</td>
<td><code>/usr/Netapp/NBUPlugin/processmanager shutdown</code></td>
</tr>
<tr>
<td></td>
<td>2011/10/17 10:49:18 Import snap failed There is no dataset named '2718'. : 22255</td>
<td>Wait 10 seconds, then type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>/usr/Netapp/NBUPlugin/processmanager startup</code></td>
</tr>
<tr>
<td>Expiration of catalog image</td>
<td>A space [ ] appears in one of the backup selections.</td>
<td>Rename the backup selection, omitting the space.</td>
</tr>
<tr>
<td>fails.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Browse operation fails from</td>
<td>The following error appears on the filer console:</td>
<td>The time on the Windows domain controller and the filer must be synchronized or have a difference of less than 5 minutes. If the difference is greater than 5 minutes, the filer does not give the Windows client CIFS share access, resulting in error on the filer console.</td>
</tr>
<tr>
<td>snapshot or replications.</td>
<td>Unable to acquire filer credentials: (0x96c73a25) Filer and domain time differ by more than 5 minutes.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** By default, the NetApp Plug-in for Symantec NetBackup is installed at the following locations:

**UNIX:** `/usr/NetApp/NBUPlugin`

**Windows:** `C:\Program Files\NetApp\NBUPlugin`
Upgrades and policies that use Instant Recovery

Under certain circumstances, the environments that upgrade to NetBackup 7.5 and use Instant Recovery may experience snapshot failure.

The problem can occur only when all of the following circumstances are true:

- The environment was upgraded to NetBackup 7.5. New NetBackup installations are not affected.
- Before the upgrade to NetBackup 7.5, policies had the Instant Recovery schedule attribute enabled.
- Policies indicate a storage lifecycle policy as the Policy storage in the policy.
- The storage lifecycle policy contains a Snapshot operation.
  See “Snapshot operation” on page 86.

To correct the problem, perform one of the following actions and rerun the backup:

- Open the policy and enable the Instant Recovery schedule attribute.
- Use a Backup operation instead of a Snapshot operation in the storage lifecycle policy.

Generating more detailed logs

For any problems that are related to snapshots and snapshot replication, increase the verbose level of the logs to generate more detailed logs.

The bpfis directory contains both the bpfis log and the OSTPlugin logs for OpenStorage partners:

```
NBU_INSTALL_PATH/logs/bpfis
```

To configure the logging level in the NetBackup Administration Console

1. Select NetBackup Management > Host Properties > Double-click on the master server > Logging.
2. Select 5 in the Global logging level drop-down menu for maximum logging.

To use the command line to set the verbose level, use bpsetconfig:

For example:

```
echo VERBOSE=5 | bpsetconfig
```

For more information about the bpsetconfig command, see the NetBackup Commands Reference Guide.

Also check the logs of the OpenStorage partner for more information.
Generating more detailed logs
Symbols
.f files in catalog 93–94
2800, Standard policy restore error 150

A
Activity Monitor
  Duplication job 98
  Index From Snapshot job 94
  Replication job 92
  Snapshot job 87
administrator account for NetBackup Client Service 110, 155
array-based snapshot
  restoring an 128
authorization
  NDMP host access 112
  NDMP user and password 112
Auto Image Replication
  Import operation 85
  Target master option 84, 92
  Target retention type 102
Auto snapshot type 108, 116

B
Backup
  From Snapshot operation 95
  job 96
  operation 85
  storage units 72
Backup From Snapshot operation 95, 115, 122
backups
  policy 105
bp.conf file 159
bpstinfo command 32, 50, 65

C
Capacity managed retention type 99, 101
cascaded topology 153
cataloging snapshots 93–94
Client Service, NetBackup 110, 155–156, 158
client version of NetBackup 109
Clone snapshot type 108, 116
configuration overview 13
convert_uode NetApp command 155
Copy-on-write technology 108, 116

D
Data Mover off-host backup method 93, 112, 117–118
DataFabric Manager 12–13, 22
Diff snapshot type 108, 116
disk array
definition 143
disk Pool Configuration Wizard 150
disk pools
  creating 50
  for snapshot replication 47
  updating 55
  updating to reflect plug-in partner updates 22, 56, 58
Disk type storage unit setting 72, 74
disk volumes
  for replication 48
Duplication
  job 98
  SLP operation 97
  troubleshooting issues 158

E
Encryption policy attribute 17
errors
  caused by time difference 150, 160
  filer console error 160
Expire after copy retention type 101

F
fanout topology 153
filer console error 160
Fixed retention type 101
G
Getting Started Wizard 14, 27, 105, 114

H
Hardware Compatibility List (HCL) from
  NetBackup 12, 22
Hyper-V backup policies 26

I
image .f files 93–94
Import snap failed message 160
import tool from NetApp 24
Independent property 76
Index From Snapshot operation 93–94, 122, 127
Instant Recovery
  upgrades to 7.5 161
Invalid command parameter (20) 150
IPv6 support 17

J
job size 139
jobs
  failure Backup From Snapshot operation 96

L
logging 161

M
Maximum concurrent jobs storage unit setting 73
Maximum snapshot limit 102
Maximum Snapshots configuration parameter 108, 116
media servers
  adding to a snapshot replication environment 44
  selecting for storage unit 42, 55, 73
Mirror property 76, 91
Mirror retention type 102
Mirror-break-off technology 108, 116
mount host 144
mount point 144

N
NAS snapshot 113
NBUPPlugin 144
  default installation location 160
  determining the version of 147

NBUPPlugin (continued)
  download site 12, 22
  IPv4 and IPv6 17
NDMP
  Data Mover off-host backup method 93, 112, 115, 117–118
  host, authorizing access 112
  Replication Director support for 111–112
NetApp
  documentation 12, 17, 21–22, 144
  hardware and software requirements 21
  import tool 24
  Plug-in for Symantec NetBackup 12–13, 17, 22, 144, 147, 149, 154, 158–160
topologies 151
NetBackup
  naming conventions 28
NetBackup 7.5 documentation, latest version 11
NetBackup Client Service (bpcd) 110, 155–156, 158
NetBackup Hardware Compatibility List (HCL) 12, 22
NetBackup_create_import dataset 160
NFS directories 110
No storage unit selection 87

O
On demand only storage unit setting 101
OnCommand Core Package 12–13, 22
operation types for storage lifecycle policies 85
Operational Restore, OpsCenter 93, 127
OpsCenter 15, 135–137, 139–140
OpsCenter Operational Restore 93, 127
OST_FIM snapshot method 107, 110, 115, 122, 144
OSTPlugin 17, 144, 161
overview, configuration 13
Overwrite existing files restore option 150

P
PFI rotation error 13 159
Plex snapshot type 108, 116
plug-in
  updates 22, 56, 58
Point in Time rollback restore 112
Point-in-time copy 108, 116
policies
  creating 105
  validation issues 155
Policy Configuration Wizard 14, 27, 105, 114
Primary property 76, 88–89
Protection Manager 156
Provisioning Manager 156
PureDisk
  storage units 100

R
replication
  disk pools for 47
  disk volumes for 48
  job 92
  source property 76, 89–91
  target property 76, 90–91
  troubleshooting issues 156
Replication Director
  adding OpenStorage credentials 44
  creating storage lifecycle policies for 81
  Disk type option 74
  use of Index From Snapshot operation in SLP 93
Replication operation 91
REQUEST_DELIVERY_TIMEOUT 159
restoring
  about restoring an array-based snapshot 122
  enabling multiple media servers 33
  files and folders from an array-based snapshot 122
  from an array-based snapshot 128
  OpenStorage partner NetApp 127
  Point in Time rollback 112
retention types for SLP operations
  Capacity managed 99, 101
  Expire after copy 101
  Fixed 101
  Maximum snapshot limit 102
  Mirror 102
  Target 102
rollback restore
  from an array-based snapshot 128
  from copy one in NetBackup 7.5 15
  OpenStorage partner NetApp 127

S
Simplified File Restore 93, 127
  See also OpsCenter Operational Restore
Single-Instance Storage (SIS) 100
Snapdupe 95
snapdupe 115

Snapshot
  storage units 72
  snapshot operation type 86
Snapshot Type configuration parameter 108, 116
snapshots
  about restoring an array-based snapshot 122
  backup policy 105
  cataloging 93–94
  from array-based storage 128
  job 87
software requirements
  NetApp 21
  NetBackup 25
Standard policy restore error (2800) 150
status codes
  1541 (snapshot creation failed) 155
  1552 (source and target storage units are not valid replication partners) 32
  156 (snapshot error encountered) 154
  223 (an invalid entry was encountered) 156
  2800 (standard policy restore error) 150
  84 (media write error) 154
storage lifecycle policies
  Capacity managed retention type 99, 101
  cataloging snapshots 93–94
  operations 81
  reporting 141
  retention types 98
  storage unit option 87
Storage server type wizard field 32
storage servers
  NTAP type 32
  updating to reflect plug-in partner updates 22, 56, 58
storage unit groups
  create for snapshots 75
  reporting 140
storage units
  configuring for replication 71
  creating 73
  reporting 140
  selection in SLP 83

T
Target retention type 102–103
throttling, NetBackup controls to ad 148
topology of storage 65–66, 151
Unicode format 155
Use Symantec's OpenStorage plug-in for network-controlled storage server option 32

vFilers 12, 22
volume-level rollback restore
  OpenStorage partner NetApp 127
vStorage backup policies 26

Windows registry 159